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ВВЕДЕНИЕ

STAR-CD является мощным инструментом CFD теплогид­
равлических расчетов и был разработан для использования в 
САЕ среде. Перечислим основные атрибуты данного пакета:

• Независимый, полностью интегрированный пакет про­
грамм с удобным пользовательским интерфейсом, включающим 
возможности пре-процессинга, расчета и пост-процессинга.

• Полная функция моделирования геометрии, охватываю­
щая даже самые сложные формы объектов, часто встречающих­
ся в промышленности.

• Расширенные возможности автоматического наложения 
сетки для сложной геометрии либо при помощи встроенных ин­
струментов (таких, как Pro*am™), либо через связанные генера­
торы сетки, такие, как ICEM CFD Tetra™.

• Встроенные модели самого широкого и постоянного об­
новляющегося диапазона явлений в потоке, включая переход­
ные процессы, сжимаемость, турбулентность, тепло- и массопе- 
ренос, химические реакции и многофазность потока.

• Быстрые и точные методики нахождения решения, повы­
шающие достоверность и уменьшающие издержки при исполь­
зовании вычислительной техники.

• Простые в использовании функции для создания и запус­
ка даже очень больших CFD моделей с использованием вне­
дренных методик параллельного расчета.

• Встроенные возможности соединения с наиболее распро­
страненными CAD/CAE системами, включая PATRAN™, 
IDEAS™, ANSYS™.

STAR-CD система разработана Computational Dynamics 
Limited. Система включает в себя основной код расчета, STAR 
(название STAR от Simulation of Turbulent flow in Arbitrary Re­
gions), а также коды для пре-процессора и постпроцессора, 
PROSTAR.
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STAR-CD был разработан инженерами для инженерных 
промышленных расчетов. Для работы с пакетом не требуется 
никаких специальных знаний по CFD, хотя желательно понима­
ние общих основ возможностей и ограничений. Структура 
STAR-CD, включая его встроенные возможности соединения с 
основными CAD системами, позволяет свободно встраиваться в 
САЕ среду. При работе в такой среде STAR-CD предоставляет 
такую же степень гибкости и удобства для пользователя, как и 
уже хорошо известные коды структурного анализа.

В настоящее время описываемые в STAR-CD типы явлений 
в потоках включают в себя:

• Устойчивые и переходные процессы -  используются 
эффективные, оптимизированные конечно-объемные алгоритмы 
решения для каждого класса проблем.

• Ламинарные и турбулентные течения -  в случае тур­
булентного течения имеется целый ряд моделей турбулентно­
сти, включая модели с низким числом Рейнольдса, двухслой­
ные, нелинейные RNG и LES модели.

• Неньютоновское и Ньютоновское течения -  с помо­
щью базовых соотношений и возможностей пользовательского 
программирования альтернативных функций может рассматри­
ваться неньютоновское течение.

• Сжимаемые и несжимаемые потоки -  внутри сжимае­
мого режима алгоритмы решения позволяют вручную управлять 
всеми скоростями потока, включая около- и сверхзвуковые.

• Теплоперенос (Конвекция, Теплопроводность и Ра­
диация) -  все эти механизмы могут существовать индивидуаль­
но или вместе. Например, можно сочетать вопросы теплопере- 
носа одновременно с конвекцией потока и теплопередачей твер­
дого тела. Моделирование радиации воспроизводит эффект лю­
бой прозрачной твердой области внутри модели, а также учет
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излучающих свойств промежуточной жидкой среды и каких- 
либо твердых частиц, присутствующих в ней.

• Массоперенос -  программой могут рассматриваться сме­
си газов или жидкостей, состоящих из не более 50 химических 
веществ.

• Химические реакции (включая горение) -  имеется не­
сколько встроенных опций для расчета химически реагирующих 
потоков, включая и те, которые контролируются химической 
кинетикой или/и турбулентным смешением. В последнем слу­
чае, акцент делается на турбулентное горение и его самые по­
следние модели. Также имеется ряд моделей для специального 
моделирования процессов горения угля.

• Распределенное сопротивление (пористая среда) -  су­
ществует возможность моделирования сопротивления для объе­
ма или плоскости для представления потока в пористой среде, 
теплообменниках, химических реакторах и т.д. Сопротивление 
может быть и не изотропным.

• Действие сил на поток (плавучесть) и Вращение -  про­
грамма имеет встроенные функции для расчета потоков с дейст­
вием на них массовых сил, а также возможности написания 
пользователем программ для добавления сил. Опция вращения -  
одна из нескольких особенностей, которые делают удобным ис­
пользование кода для применения в случае вращающихся ма­
шин и механизмов.

• Течение со свободной поверхностью и Кавитация -  
STAR может быть использован для вопросов, требующих одно­
временного CFD анализа областей с высоко- и низкомолекуляр­
ной жидкостью, а также их контакта. Моделирование касается 
вопросов сил натяжения поверхности жидкости и применяет 
специальную схему дискретизации, при которой исключены фа­
зовые взаимодействия. Проблемы кавитации моделируются при 
помощи расширения алгоритмов со свободной поверхностью.
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• Множественные потоки -  STAR имеет возможность од­
новременного расчета множественных независимых потоков, 
каждый из которых может быть отдельной жидкостью, и все они 
могут взаимодействовать термически через разделяющие их 
стенки. Типичным примером применения таких потоков могут 
служить теплообменники.

• Дисперсные многофазные потоки -  можно проводить 
расчет многофазных систем, содержащих частицы, пузырьки 
или капли в сплошной жидкой фазе, с учетом перехода тепла, 
массы и момента движения между фазами.

PROSTAR -  это интерактивный, командно- и с помощью 
меню управляемый комбинированный пре-процессор и пост­
процессор с функцией он-лайн помощи. Его основные функции 
включают в себя:

• Моделирование Геометрии и Создание Сетки
• Описание Проблемы (например, задание свойств жидко­

сти, граничных условий, параметров контроля и т.д.)
• Вывод и Управление Результатами
• Управление Файлами
• Соединение с Внешними CAD/CAE системами
• Специальный графический интерфейс (STAR GUIde), на­

правляющий пользователя от стадии к стадии при задании CFD 
модели.

В ряде случаев авторы пособия ссылаются на литературные 
источники, предоставленные представителями разработчика 
программного продукта STAR-CD, а именно книгу «Специали­
зированный пакет прикладных программ вычислительной гид­
рогазодинамики STAR-CD»:

Часть Е Методология применения пакета STAR-CD версия
3.15;

Часть II. Руководство пользователя пакета STAR-CD вер­
сия 3.15.



1. О СН О В Н Ы Е ПРИНЦИПЫ CFD МОДЕЛИРОВАНИЯ 
В ВЫ ЧИ СЛИ ТЕЛЬН О Й  ГИДРОДИНАМИКЕ

Цель данного раздела -  познакомить пользователя с наибо­
лее важными вопросами, с которыми он столкнется при поста­
новке и решении задач по термогидравлике с использованием 
CFD кода. Предполагается, что пользователь знаком с материа­
лами, содержащимися в книге «Методология применения пакета 
STAR-CD».

Процесс компьютерного моделирования течения обычно не 
начинается непосредственно с использования CFD кода. Очень 
важно понимать, что STAR-CD -  это всего лишь инструмент, 
призванный помочь инженеру в понимании физического явле­
ния. Успех или неудача при моделировании жидкой или газооб­
разной среды зависит не только от возможностей программы, но 
и от исходных данных, таких, как:

• Геометрия области течения,
• Свойства жидкости или газа,
• Граничные условия,
• Параметры контроля за ходом решения.
Чтобы моделирование имело шансы на успех, эта инфор­

мация должна быть физически реалистичной и в правильной 
форме представлена в программе.

Моделированию задачи по вычислительной гидродинамике 
должны предшествовать следующие шаги:

• Сформулируйте задачу в физических терминах.
• Определите объем имеющейся информации, ее достаточ­

ность и адекватность.
• Оцените возможности и средства CFD пакета, чтобы убе­

диться, что задача правильно сформулирована и может быть 
численно решена программой.

• Тщательно спланируйте стратегию моделирования, ис­
пользуя метод пошагового приближения к финальному решению.
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Основной процесс моделирования

Процесс моделирования можно разделить на четыре основ­
ных этапа.

Этап 1 -Разработка стратегии моделирования

На этом этапе необходимо точно определить геометрию 
физической системы, свойств материалов и параметры потока, 
основываясь на хорошем понимании физики явления. Первый 
этап включает следующие задачи:

• Планирование вычислительной сетки (количество ячеек, 
распределение размеров ячеек и т.д.).

• Оценка численных величин для соответствующих физи­
ческих параметров (например, плотность, вязкость, удельная 
теплоемкость и т.д.).

• Выбор моделирующей опции, наиболее подходящей для 
данного случая (например, турбулентная модель, модель горе­
ния и т.д.).

Пользователь также должен сопоставить требования физи­
ческой и численной точности со стоимостью и затратами на мо­
делирование и вычислительными возможностями своей систе­
мы. Стратегия моделирования должна представлять компромисс 
между этими двумя факторами.

Этап 2 -Задание модели течения с использованиемPROSTAR

Основные задачи на данном этапе:
• Создание расчетной сетки для отображения области тече­

ния (модельная геометрия).
• Определение термо-физических свойств жидкостей, газов 

и/или твердых тел, участвующих в моделировании, и там, где 
нужно, -  модели (или моделей) турбулентности, массовых сил 
ит. д.
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• Установка параметров решения (выбор переменных ре­
шения, коэффициентов релаксации и т.д.) и форматов выходных 
данных.

• Определение расположения и описания границ, а для за­
дач по моделированию неустановившихся течений -  дальней­
шее описание переходных граничных условий и шагов по вре­
мени.

• Подготовка соответствующих файлов в качестве выход­
ных данных для аналитического расчета на следующем этапе.

Этап 3 -  проведение анализа течения с использованием 
пакета STAR-CD

Этот этап состоит из:
• Чтения входных данных, созданных в PROSTAR, и при 

рестарте -  результатов прошлых расчетов.
• Оценки прогресса расчетов, путем анализа различных 

данных и статистики решений, приведенных в STAR-CD.

Этап 4 -  Пост-обработкарезультатов с использованием 
препроцессора PROSTAR

Этот этап включает отображение и обработку выходных 
данных, созданных пакетом STAR-CD, с использованием соот­
ветствующих функций препроцессора PROSTAR.
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2. ПРОСТРАНСТВЕННОЕ ОПИСАНИЕ И ДИСКРЕТИЗАЦИЯ ОБЪЕМА

Один из основных шагов при подготовке CFD модели -  
описание геометрии задачи. Две ключевые составляющие этого 
описания следующие:

• Определение габаритных размеров и формы области тече­
ния, относительно которой и решаются все основные уравнения.

• Покрытие области сеткой, состоящей из дискретных, ко­
нечных и смежных объемных элементов, или ячеек.

Этот процесс называется дискретизацией объемов и явля­
ется важной частью численного решения вышеупомянутых 
уравнений. В STAR-CD обе составляющие пространственного 
описания выполняются как часть одной операции -  построения 
сетки конечных объемов, -  но рассматриваются с различных по­
зиций.

2.1. Определение области решения

Благодаря своему внутреннему строению и структуре, 
STAR-CD дает возможность широкого и гибкого определения 
того, что является областью решения. Это может быть:

-  поле тока жидкости, газа и/или теплового потока, зани­
мающее открытую область или пространство;

-  жидкость, газ и/или тепловая энергия, текущие через по­
ристую среду;

-  тепловая энергия, текущая через твердое тело.
Можно также задать произвольную комбинацию этих трех 

основных видов переноса в рамках одной модели, как, напри­
мер, при анализе сопряженного теплообмена. Поэтому первая 
задача пользователя -  определить, какие участки моделируемой 
системы необходимо включить в область решения и какой сре­
дой заполнен каждый участок. Каким бы ни было сочетание, 
главное требование к области решения -  это то, что она должна 
быть последовательна. Это означает, что пользователь должен 
тщательно изучить геометрию своей системы и точно опреде­
лить положение границ.
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2.2. Построение сетки

Построение сетки, состоящей из конечно-объемных ячеек, 
для представления области решения -  это задача, которая обыч­
но занимает больше всего времени при создании CFD модели. 
Этот процесс значительно облегчается использованием пакета 
STAR-CD, благодаря его способности

-  генерировать широкий спектр базовых форм ячеек,
-  использовать неструктурированные сетки.
Это значит, что всегда можно сделать так, чтобы сетка точ­

но соответствовала форме области решения без необходимости 
генерирования «пассивных» или «пустых» ячеек.

При создании конечно-объемных сеток пользователь дол­
жен стремиться точно представить две следующие особенности 
объекта:

1. Полную внешнюю геометрию расчетной области, путем 
задания соответствующих размеров и форм пограничных ячеек. 
Наружные поверхности последних вместе составляют поверх­
ность, которая адекватно представляет форму границ расчетной 
области. Могут возникать небольшие неточности из-за того, что 
все поверхности ячеек (включая прямоугольные поверхности) 
состоят из треугольных граней. Эти неточности уменьшаются 
при применении встроенной процедуры измельчения и повыше­
ния качества сетки.

2. Внутренние свойства режима течения. Это достигается 
путем тщательного контроля за разбивкой сетки внутри внут­
ренней части расчетной области, таким образом, что сетка наи­
более сгущена в местах, где параметры потока изменяются наи­
более быстро. Пристеночные области очень важны, необходима 
высокая плотность сетки, чтобы получить течение вблизи стен­
ки. Этот вопрос подробно рассматривается в гл. 3 Руководства 
пользователя.
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2.3. Создание сетки -  основные подходы

Существует три основных подхода к созданию сетки в 
PROSTAR:

• Простейшие геометрические структуры (геометрические 
примитивы)

• Экструзия (выдавливание) двухмерных образов
• Блочный подход к созданию сетки

2.3.1. Построение простых сеток

Отдельные части сетки с регулярной структурой могут 
быть созданы с помощью всего одной операции. Форма сетки 
при этом определяется используемой системой координат.

Если геометрия задачи может быть разделена на такие про­
стые области, то это самый быстрый способ создания сетки.

Простые сетки такого типа могут быть созданы с помощью 
STAR GUIde (Create and Import Grids > Create Grids > Create 
3-D Grids using Simple Shapes).

NAV prjp

3  select analysis Features 

I Create and Import Geometry 

^ 7  Create and Import Grids 

Si Import Grids 

Create Grids

Si Create 2-D Grids using 

T = l create 3-D Grids using^ >

Create Block Structure

Рис .2.1. Панель графического интерфейса пользователя для построения сеток
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С оответствую щ ая панель показана вы ш е. Е й  соответствует 

ком ан да VC3DGEN. П ом ните, что ком ан да создает блок сетки  из 

ячеек того типа, которы й активен  в дан ны й м ом ент, в активной 

систем е координ ат (активны й ти п  ячеек и  активная си стем а к о ­

ординат задаю тся ком андам и c t y p e  и  c s y s ) .

Выбор системы 
координат 
и типа ячеек

Диапазон изменения 
координаты и число 
ячеек сетки для 
каждого направления

Генерация сетки

Create 3-D  Grids using 
Simple Shapes

Current Coordinate System : 

2 -  Global Cylindrical

Current Cell Type :

1 - Fluid

S e le c t а S e lec t
C oordinate S y s te m Cell T y p e

Extent o f Domain :

Minimum Maximum Number o f Cells

|o.2 |o.e b
R R R

| SO 1180 | i o
T h e ta T h e ta TTieta

I 0 .0 | 0 .4 b
Z z Z

G e n era te D elete an d  C om press
M esh All Cells an d  V ertices

Рис. 2.2. Последовательность действий при построении сеток
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2.3.2. Экструзия

Экструзия -  это «выдавливание» двухмерного образа сетки.

Рис. 2.3. Двухмерный образ сетки, 
созданный из плоских ячеек типа оболочка (shell)

Рис. 2.4. Экструзия двухмерной сетки для получения трехмерной сетки

Двумерная геометрия формируется из плоских ячеек типа 
оболочка (shell). В простейшем случае двухмерные сетки созда­
ются в STAR GUIde системе с помощью панели Create and 
Im port Grids > Create Grids > Create 2-D Grids using Simple 
Shapes (или с помощью команды VC2DGEN).
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2.3.3. Создание двухмерной сетки с помощью шаблонов

В более сложных случаях, когда ребра расчетной области 
являются сложными кривыми или опорная двумерная поверх­
ность не является поверхностью постоянного значения какой- 
либо координаты, можно воспользоваться командой p a tc h ,  ко­
торая генерирует структурированную двумерную сетку -  шаб­
лон. Границы таких шаблонов описываться пространственными 
сплайнами, если сплайн содержит в себе излом (угловую точку), 
то одна из вершин генерируемой двумерной сетки обязательно 
будет совпадать с угловой точкой с целью максимально точного 
воспроизведения геометрии.

Вершины ячеек на границе двух двумерных областей авто­
матически не сливаются, т.е. для объединения двух областей 
сетки в единое целое необходимо дополнительно выполнить 
операцию объединения (merge) (Creat and Import Grids > 
Assemble Grids). Отдельные оболочки можно создавать с по­
мощью команд с и cdx. Качество двухмерной сетки можно 
улучшить с помощью операции сглаживания (smooth) (Check 
and Fix Grid > Fix Grid Problems) или непосрественных мани­
пуляций вершинами, определяющими оболочки.

Двухмерная сетка задается диапазоном изменения двух 
первых координат активной системы координат (например, X  и 
Y для декартовой системы координат; R и 0 для цилиндрической 
системы координат). Это значит, что сетка будет лежать в плос­
кости третьей координаты (например, Z). Примеры приведены 
на следующей странице.

Для решения двумерных (плоских или осесимметричных) 
задач генерируется пространственная сетка толщиной в одну 
ячейку, причем для плоской задачи сетка автоматически допол­
няется граничными условиями симметрии, а для осесимметрич­
ных -  граничными условиями циклической симметрии. Ячейки 
и граничные условия генерируются после нажатия на кнопку
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Generate 3-D mesh from 2-D Mesh на панели, показанной выше. 
При этом оболочки трансформируются в объемные ячейки тол­
щиной в 10% от максимального линейного размера исходной 
двухмерной сетки.

Выбор системы коор­
динат и типа ячеек

Диапазон изменения 
координаты и число 
ячеек сетки для каждого 
направления

Генерация ячеек 
плоской сетки

Create 2-D Grids using 
Simple Shapes

Current Coordinate System : 

Z -  Global Cylindrical

Current Cell Type:

S elec t a  
Coordiiate System

S elec t 
Cell Type

Extent ol Domain :

Minimum Maximum Number of Cells

10.0

Tlieta Tlieta Ttieta

Generate 2 -D 
Mesh

Generate 3-D mesh 
from Z-D Mesh

Delete and compress 
All Cells and Vertices

Рис. 2.5. Основные кнопки, используемые при создании сетки 
с помощью шаблонов 
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Участок структури­
рованной сетки, 
сформированный 
с помощью команды 
p a tc h

Рис. 2.6. Пример создания двухмерной сетки с помощью шаблонов (patch)

Шаблоны задаются четырьмя вершинами, которые опреде­
ляют его углы, а стороны определяются сплайнами, соединяю­
щими угловые вершины. Дополнительные «углы» могут быть 
введены как точки излома сплайнов-сторон, как показано на 
рис. 2.6. Помимо номеров вершин, определяющих углы шабло­
на, для команды p a t c h  необходима информация о числе ячеек 
по каждому направлению. Отметим, что в общем случае шаблон 
представляет собой искривленную пространственную поверх­
ность любой геометрической сложности и не обязан принадле­
жать какой-либо плоскости.

Созданный слой двумерных оболочек можно экструдировать 
(выдавить) в трехмерную объемную сетку. Это делается с помощью 
команды v c e x tru d e . Команда v c e x tru d e  работает следующим 
образом: создается копия набора вершин, определяющих ячейки- 
оболочки опорной двумерной сетки. Номера вершин при этом 
отличаются от исходных на заданную величину. Затем созданные 
вершины смещаются на заданное расстояние. На основе двух 
наборов вершин создаются объемные ячейки. Затем процесс 
создания вершин и ячеек повторяется заданное число раз.

Тот факт, что номера соответствующих вершин в каждом 
слое отличаются на постоянную заданную величину можно ис­
пользовать для модификации однородной сетки в неоднородную

19



по направлению выдавливания. Это можно сделать с помощью 
команды v f i l l .  (Примечание: Начиная с версии 3.15 команда 
v c e x t r u d e  позволяет сразу создавать неоднородную сетку.)

Рис. 2.7. Конечный вид получившейся сетки

2.3.4. Блочный метод построения

Использование блочной технологии предполагает разбие­
ние расчетной области на несколько регулярных трехмерных 
блоков. Создание сетки с помощью блоков является достаточно 
эффективным и универсальным подходом. На рисунке приведен 
пример построения сетки вокруг профиля, расположенного над 
усеченным конусом (показаны два вида).

Рис. 2.8. Разбиение модели на блоки и нумерация блоков 
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Ячейки, принадлежащие шести различным блокам, имеют 
разный тип и окрашены в разный цвет. Контуры и нумерация бло­
ков, на базе которых генерировалась сетка, показаны на рис. 2.8.

В PROSTAR блок является самостоятельным примитивом, 
так же как вершина, сплайн или ячейка Свойства блоков во мно­
гом аналогичны ячейкам -  каждый из них имеет свой номер и их 
можно группировать в наборы. При смещении вершины, зада­
ющей угол блока, а также при изменении формы сплайна между 
двумя углами форма блока изменяется. (Примечание: Изменение 
формы блока после генерации сетки не влияет на сетку!)

Блок определяется 
восемью вершинами, 
расположенными по углам

:з
По ребрам блока 
задается разбивка 
в каждом направлении

При генерации сетки для блока, 
вершины ячеек будут принадле­
жать сплайнам-ребрам, соеди­
няющим углы блока

Рис. 2.9. Этапы построения блока

Для создания блоков и работы с ними удобно использовать 
STAR GUIde

На вкладке Blocks пользователь может воспользоваться 
следующими опциями:

Creat Block -  создание блока, предлагается выбрать восемь 
угловых вершин блока;

Modify Block -  изменить одну или несколько опорных вер­
шин блока;

Delete Block -  уничтожить блок;
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Block Plot -  отрисовать блок и его разбивку на ячейки, без 
выполнения генерации сетки.

3*«»
а ., .- . у , - . Выберите операцию 

и следуйте инструк­
циям системы

C ru ti Grids with Blocks 1
(F*«J Shtpts) Э * -

Рис. 2.10. Пример использования панели Create Grids with Blocks

Во вкладке Mesh пользователь может воспользоваться сле­
дующими опциями:

Number o f Cell -  задание числа разбиений на ячейки вдоль 
ребра блока;

Space Factor -  задание коэффициента сгущения сетки 
вдоль ребра;

Block Trace -  передача разбивки ребра блока всему теку­
щему набору. Эта операция гарантирует полную совместимость 
в топологии сетки нескольких сопряженных блоков;

Map Face То Shell -  совместить грань блока с заданным 
набором оболочек. При этом вершины генерируемых ячеек бу­
дут совпадать с поверхностью, определяемой оболочками;

Generate Factors -  задание разбивки вдоль ребра блока 
посредством задания номинального размера ячейки для этого 
ребра;
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Generate Mesh -  генерация сетки по параметрам блока;
Delete Block Cells -  уничтожение ячеек, сгенерированных 

для блока.
Помните, что список Selected Items изменяется в зависимо­

сти от выбранной операции.
Параметры блока можно проверить и изменить при помощи 

диалогового окна Block List из меню List > Blocks

U pdate List

Shaw  /ЛИ Blocks■s/ Show  Block S e t  Onlv

Modify Block

C u rre n t  Cell R an g e : Spacing Factor

Mapping Shell Cell ID’s

Рис. 2.11. Диалоговое окно Block List из меню List > Blocks

Кроме того:
• Вершины-углы, формирующие блок, перечисляются как 

N1,N2, ... N8.
• Помните, что существуют дополнительные опции, реали­

зуемые через данное диалоговое окно, которые отсутствуют в 
системе STAR GUIde (как, например, начальный номер вершин 
Start Vert #, начальный номер ячеек Start Cell # и т.д.).

• Номер типа ячеек, которые будут созданы для блока, за­
дается в поле Cell Туре.

• По окончании изменения параметров блока необходимо 
нажать на кнопку Define Factors.

В процессе создания сетки пользователь может комбиниро­
вать все три способа.
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Г енерация 
в виде простейшей 
трехмерной формы

Г енерация 
с помощью блока, 
заданного 
с помощью 
сплайнов 
и вершин

Обратите 
внимание 
на произвольную 
стыковку двух 
частей сетки

Экструзия из слоя 
оболочек, созданных 
на существующей 
поверхности

Рис. 2.12. Пример использования комбинации всех трех способов

Пользователю нет необходимости создавать сетку, исполь­
зуя только один из описанных подходов. Точно так же созда­
ваемые в PROSTAR сетки могут свободно комбинироваться с 
сетками, которые созданы во внешних пакетах (таких, как ICEM 
Tetra, SAMM, IDEAS, PATRAN и т.д.).
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3. ЗАДАНИЕ ПАРАМЕТРОВ ТЕЧЕНИЯ И СВОЙСТВ МАТЕРИАЛА

Правильное задание физических параметров течения и 
свойств материалов является важным условием получения пра­
вильного решения задачи или, точнее, получения вообще како­
го-либо решения. Это также важно, чтобы определить, может ли 
задача быть смоделирована пакетом STAR-CD. Поэтому, поль­
зователь должен убедиться, что задача правильно задана отно­
сительно:

• природы течения (например, стационарная/неустановив- 
шаяся, ламинарная/турбулентная, несжимаемая/сжимаемая),

• термофизических свойств (например, плотности, вязко­
сти, удельной теплоемкости),

• внешних силовых полей (например, гравитационных и 
центробежных сил) и источников энергии, если таковые имеются,

• начальных условий для переходных течений.

3.1. Природа течения

Очень важно понимать природу анализируемого течения 
для того, чтобы выбрать подходящие математические модели и 
алгоритмы численных решений. Если выбор сделан неверно, то 
могут возникнуть проблемы, как в примерах, перечисленных 
ниже:

• Использование алгоритма итеративного, стационарного 
течения для задачи, которая в основе своей нестационарная, на­
пример «срыв» вихрей за плохо обтекаемым телом;

• Получение турбулентного течения без использования со­
ответствующей модели турбулентности;

• Моделирование неустановивишегося течения с использо­
ванием одной из моделей турбулентности, которая в настоящее 
время имеется в STAR-CD. Ни одна из них не может точно 
представить неустановившееся поведение.
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3.2. Теплофизические свойства

Задание физических свойств, таких, как плотность, молеку­
лярная вязкость, теплопроводность и т.п., зависит от природы 
рассчитываемых течений или твердых тел, а также от условий 
их использования. Например, STAR-CD содержит несколько 
встроенных уравнений состояния, из которых плотность можно 
вычислить как функцию одной или нескольких переменных:

-  давления,
-  температуры,
-  состава жидкости или газа.
Во всех случаях, где используются сложные вычисления 

для определения свойств материала, рекомендуются следующие 
меры:

-  должны быть определены относительные переменные по­
ля, соответствующие приемлемым начальным и граничным ве­
личинам;

-  где необходимо, свойства должны быть вычислены вме­
сте с переменными поля как часть общего решения;

-  в случае сильных зависимостей между свойствами и пе­
ременными поля пользователь должен учитывать значение ко­
эффициента нижней релаксации, как описано в Методологии 
(гл. 7 «Скалярные уравнения переноса»);

-  когда необходимо, можно использовать имеющуюся в 
STAR-CD возможность альтернативных функций, программи­
руемых пользователем.

3.3. Силовые поля и источники энергии

Как уже отмечалось, пакет STAR-CD имеет встроенную 
функцию вычисления массовых сил, возникающих в результате:

-  естественной конвекции,
-  вращения.
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Важно помнить, что, поскольку интенсивность массовых 
сил увеличивается относительно вязкостных сил (или турбу­
лентных) напряжений, течение может быть физически неустой­
чивым. В этом случае рекомендуется переключиться в режим 
неустановившихся решений.

Также можно ввести дополнительные, внешние силовые 
поля и источники энергии посредством программируемых поль­
зователем возможностей STAR-CD. В таких случаях важно по­
нимать физический смысл и избегать задание условий, которые 
ведут к физической или численной неустойчивости. Примеры 
таких условий:

• Источники тепловой энергии, которые линейно увеличи­
ваются с увеличением температуры, могут приводить к физиче­
ской неустойчивости, называемой «тепловым убеганием».

• Задание коэффициента рг в функции проницаемости 
/б = а ; | v| + Р( таким образом, что его значение будет очень ма­

лым или равным нулю. Если локальная скорость жидкости или 
газа также станет очень малой, то результатом может явиться 
неустойчивость численного решения, когда небольшое воз­
мущение давления влечет за собой большое изменение скоро­
стей.

3.4. Задание свойств и термофизических моделей 
с помощью панелей GUIde

В подавляющем большинстве случаев CFD моделирования 
требуется задание только одного материала -  жидкости. Тем не 
менее для задач сопряженного теплообмена (см. рис. 3.1), может 
встать необходимость в задании как минимум одного твердого 
тела, а возможно, и нескольких потоков. То есть потребуется 
задавать различные свойства расчетным ячейкам, в зависимости 
от того, из какого материала они состоят.
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Панель Thermophysical Models and Properties предоставляет 
пользователю средства для задания моделей теплофизических 
свойств жидкостей и ввода констант, соответствующих тому 
или иному материалу. Так, например, для разных потоков в мо­
дели могут использоваться различные модели турбулентности. 
В связи с этим, перед заданием граничных условий, обязатель­
ным является определение теплофизической модели свойств 
жидкости(ей). В зависимости от модели жидкости, программа 
перестроится на запрос у пользователя дополнительной исход­
ной информации, требуемой для формирования граничных 
условий и расчетной модели.

ж и д к о с т ь  N  1п о р и с т а я  о б л а с т ь

п е р е г о р о д к а  
т и п а  b a f f le

т в е р д о е  т е п о  N 1 Ж и д к о с т ь  N  2

т в е р д о е  т е л о  N  2

Рис. 3.1. Пример определения свойств среды 
для модели сопряженного теплообмена

Перед заданием свойств материалов необходимо просмот­
реть текущее состояние панели ячеек Cell Table Editor и убе­
диться в том, что в данный момент активизирован нужный на­
бор (номер) ячеек. Номера свойств представлены в окне Material 
Number. К панели можно перейти через Tool > Cell Tool... > Edit 
Types... или нажав в главном окне на кнопку СТАВ.

Нужный материал может включать в себя ячейки несколь­
ких типов. Однако в пределах одного потока возможна работа 
только с одним типом материала.
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Рис. 3.2. Панель Cell Table Editor

Теплофизические модели и свойства материалов в про­
грамме задаются в разделе Thermophysical Models and Properties.

Раздел Thermophysical Models and Properties состоит из пя­
ти папок-подразделов:

Thermal Options (тепловые опции) -  подключает к решате­
лю ряд специальных тепловых опций, необходимость активиза­
ции которых определяется задачей.

Liquids and Gases (жидкости и газы) -  предоставляет поль­
зователю возможность задания математических моделей 
свойств жидкости в сочетании с необходимыми константами.

Additional Scalars (дополнительные скаляры) -  позволяет 
пользователю задавать скалярные переменные, которые допол­
няют глобальные установки.

Solids (твердые тела) -  позволяет пользователю задавать 
физические свойства твердых матриалов.

Porosity (пористость) -  дает возможность задать пористые 
свойства ячейкам которые связаны с жидкостями, через соот­
ветствующие коэффициенты. По умолчанию эти коэффициенты 
равны нулю.
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Рис. 3.3. Последовательность выбора панели 
Thermophysical Models and Properties

Свойства жидкости задаются применительно к материалам, 
которые состоят из ячеек жидкостного типа. То же самое каса­
ется и твердых тел. Для определения модели и свойств для каж­
дого конкретного материала панель имеет переключатель бе- 
гункового типа -  Material #, который позволяет пользователю в 
нужный момент осуществлять выбор.

3.4.1. Задание тепловых опций

С помощью панели Thermal Options пользователь может 
активизировать в процедуре расчета три дополнительных тепло­
вых опции -  тепловое излучение, солнечное излучение и сопря­
женный тепломассообмен.

Они активизируются глобально, т.е. применительно ко всей 
модели, а не к одному частному материалу. В рамках данного 
курса эти тепловые опции не рассматриваются, хотя более под­
робную информацию вы можете найти:

-  по излучению: гл. 9 Методологии, гл. 11 Руководства 
пользователя,
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-  по сопряженному теплообмену: гл. 1, 14 Методологии, 
гл. 15 Руководства пользователя.
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T h e r m a l  O p t i o n s

♦  Radiation Off

♦  Heat Transfer Off

Рис. 3.4. Последовательность открытия панели Thermal Options

3.4.2. Задание молекулярных свойств среды
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Рис. 3.5. Панели, используемые для задания плотности: 
Liquids and Gases>Molecular Properties
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Задание параметра «плотность». Математическая модель, 
описывающая закон изменения плотности жидкости может быть 
задана в следующей форме (см. уравнения гл. 1 Методологии):

• В виде постоянной величины -  Constant.
• В виде функции от химического состава жидкости (при 

этом каждая компонента жидкости должна иметь постоянную 
плотность, и соответствующие им скаляры активизированы) -  
MultiComp. Величины описываются с помощью уравнения 
(1-32) гл. 1 Методологии.

• В виде функции от температуры при изобарическом за­
коне изменения плотности -  Isobaric. Эта формула включает 
в себя исходную плотность и коэффициент объемного расшире­
ния (уравнений (1-33), (1-34) гл. 1 Методологии).

• В виде функции идеального газа Ideal-f(T,P) или закона 
идеального газа без учета влияния давления Ideal-f(T). Обе оп­
ции идеального газа будут учитывать присутствие эффекта из­
менения химического состава смеси, при этом обязательным 
условием является то, что скаляры являются активными. Опция 
Ideal-f(T) фиксирует давление идеального газа на уровне кон­
трольной величины, задаваемой пользователем для данного ма­
териала (см. уравнение (1-35) гл. 1 Методологии).

• В виде функции от нескольких переменных, которая за­
дается с помощью пользовательской подпрограммы -  User.

Задание параметра «молекулярная вязкость». Математиче­
ская модель, описывающая закон изменения молекулярной ди­
намической вязкости, может быть задана в одной из следующих 
форм (см. уравнения из гл. 1 Методологии):

• В виде постоянной величины -  Constant.
• Ей можно пренебречь для проведения расчета без учета 

вязкости среды -  In viscid. Аналогичного результата можно до­
биться, если задать величину вязкости величиной в 1.0Е-30.
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В этом случае решатель автоматически перейдет на расчет не­
вязкого потока для текущего материала.

Molecular Properties for

C e n t e r -  Density
Л Constant _ i  density 1205 kg/m3

3  Select Analysis Features 

_ J  Create and linpurl Geuinetry

_ l  Create and Import Grids 

_ J  Clieck and Rx Grid 

_ J  Locate Boundaries 

I Qieck/Rx Dountlary Locations 

r7T liem iophysical Models and P 

"“ I  Thermal Options 
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Inviscid 

Multi Comp, 
_  Nonllewt, 

_  Sutlieriand

Polynomial 
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Cv 100Б J/KgK

JolecuLir Properties^

Рис. 3.6. Выбор панелей для задания свойств 
«плотность» и «молекулярная вязкость»

• Может варьироваться в зависимости от изменения хи­
мического состава жидкости (согласно уравнению (1-36) гл. 1 
Методологии при обязательном наличии активных скаляров 
компонент MultiComp).

• Можно задать неньютоновский характер поведения в 
соответствии с моделью Оствальда-де Ваеле -  NonNewt. Более 
полная информация -  в гл. 14 Методологии.

• В виде функции температуры по закону Сазерленда (см. 
уравнения гл. 1 Методологии) -  Sutherland.

• В виде функции температуры, задаваемой в виде поли­
нома (см. уравнения гл. 1 Методологии) -  Polynomial.

• В виде функции от нескольких переменных, которая за­
дается с помощью пользовательской подпрограммы -  User.

Если жидкость имеет переменную плотность, то задается 
параметр Ср. Если плотность жидкости постоянна, то задается
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параметр Cv. Теплоемкость жидкости может быть задана сле­
дующим образом (см. уравнения гл. 1 Методологии):

• В виде постоянной величины -  Constant.
• В виде функции от химического состава жидкости (со­

гласно уравнению 1-36) при условии наличия активных скаля­
ров -  MultiComp. Величины описываются с помощью уравне­
ния (1-32).

• В виде функции температуры, задаваемой в виде полино­
ма (см. уравнение (1-37)) -  Polynomial.

• В виде функции от температуры и химического состава, за­
даваемой с помощью пользовательской подпрограммы -  User-Cp.

Три ниже приводимые опции используются для изменения 
соотношения температуры и энтальпии:

• Энтальпия становится функцией температуры (и при не­
обходимости активных скаляров), которая задается с помощью 
пользовательской подпрограммы -  User-H(T).

• Температура становится функцией энтальпии (и при не­
обходимости активных скаляров), которая задается с помощью 
пользовательской подпрограммы -  User-T(H).

• Температура и энтальпия становится функциями друг 
друга с помощью пользовательской подпрограммы -  User-Both.

Теплопроводность жидкости может быть задана следую­
щим образом (см. уравнения гл. 1 Методологии):

• В виде постоянной величины -  Constant.
• В виде функции от химического состава жидкости (со­

гласно уравнению 1-36) при условии наличия активных скаля­
ров -  MultiComp.

• В виде функции температуры, задаваемой в виде полино­
миальной функции (уравнение 1-38) -  Polynomial.

• В виде функции от произвольных переменных, задавае­
мых с помощью пользовательской подпрограммы -  User.
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PROSTAR имеет свою базу данных со свойствами наиболее 
часто моделируемых жидкостей. Данные внутренней базы дан­
ных хранятся в файле props.dbs. Для того чтобы воспользоваться 
имеющейся информацией, выберите нужную жидкость или газ 
из списка Fluid Data Base и нажмите на кнопку Apply.

Диалоговый список Fluid Data Base позволяет пользовате­
лю просматривать информацию в базе данных. Для просмотра 
данных пользователю необходимо выбрать интересующий его 
материал из списка, имеющегося на экране.

Если для описания какого-либо из свойств пользователь 
воспользуется опцией Polinomial, то это автоматически пере­
ключит работу на процесс задания аппроксимационного поли­
нома с помощью панели Polynomial Function Definition.

Данная панель позволяет пользователю вводить коэффици­
енты аппроксимирующего полинома функций, описывающих 
свойства жидкости. Пользователю необходимо задать диапазон 
температур и соответствующие коэффициенты в специально 
предусмотренные для этого текстовые окна, а затем нажать на 
кнопку Apply Coefficients.

Для часто используемых материалов программа имеет свою 
внутреннюю базу данных коэффициентов теплоемкости -  
CHEMKIN и СЕС.
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Рис. 3.7. Вид панели Polynomial Function Definition 
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Для того чтобы воспользоваться базой из списка Data Base, 
необходимо выбрать требуемый материал, после чего необхо­
димо отжать кнопку на исполнение Apply Data Base Substance.

T u rb u le n ce  M o d e ls  ap p lied  to  AIR

V  on (I jr. U ntar Sow) 

On

Nav^
C enter

РГапКЦГр!) j I Л 9

m n r a ( H ii i )  [ ii i  v m h  _» j

Рис. 3.8. Выбор модели турбулентаости для среды

В случае необходимости использования в процессе моде­
лирования жидкости одной из моделей турбулентности, послед­
нюю активизируют для каждой жидкости по отдельности. Мо­
дель турбулентности выбирается из меню так, как это показано 
на приводимом выше рисунке. Специфика каждой модели об­
суждается в гл. 2 Методологии. Пользователь может изменить 
любой из стандартных коэффициентов, задаваемых программой 
по умолчанию. Доступ к текстовым полям коэффициентов осу­
ществляется выбором опции Show Coefficients. При этом следует 
проявлять крайнюю осторожность и четко представлять себе 
физический смысл производимых вами изменений.

Пользователю необходимо иметь в виду специфику при­
стеночных областей. Для них более предпочтительным является 
использование низкорейнольдсовых и LES моделей турбулент­
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ности, так как в случае их использования может отпасть необ­
ходимость в дополнительной обработке. Для моделей с боль­
шими числами Рейнольдса такой тип расчета известен как «за­
кон стенки» или «функция пристеночной области». Эти уравне­
ния относятся к моделям нулевого уровня и описываются в гл. 6 
Методологии. Вкладка Two-Layer позволяет пользователю под­
ключить к расчету одну из многочисленных моделей нулевого 
уровня для описания пристеночной области. Список пристеноч­
ных функций, на выбор предлагаемых пользователю, включает в 
себя модели Норриса и Рейнольдса, Хассида и Пореха, Вольф- 
штейна и Ван Драейста, а также любую пользовательскую мо­
дель задаваемую подпрограммой. Помните, что расчет по функ­
циям стенки выполняется только для тех ячеек, которые при­
надлежат пристеночным областям. Таким образом, пользователь 
получает возможность в расчете использовать комбинацию при­
стеночной функции и двухуровневой модели для центральной 
высоко турболизированной части потока.

Если турбулентность моделируется двух уровневой моде­
лью, то в пристеночной области необходимо создать мелкую 
сетку (см. гл. 6 Руководства пользователя). Аналогичные сооб­
ражения касаются LES и низкорейнольдсовых моделей, где мо­
жет потребоваться еще более мелкая сетка. Хотя в виде опции 
LES модель можно комбинировать с пристеночной функцией 
для уменьшения плотности сетки.

3.4.3. Задание термофизической модели

При моделировании потоков, для которых крайне важным 
является изменение температуры (теплоперенос, процесс сжатия 
потока и т.д.), к решателю необходимо подключить уравнение 
сохранения энергии. Эта опция активизируется с помощью па­
нели Thermal Models и изменяется в зависимости от используе­
мого материала. Для переменной Conservation пользователь мо­
жет реализовать несколько альтернатив (см. гл. 1 Методологии):
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Static Enthalpy, Total Enthalpy и Rothalpy (т.е. статическая эн­
тальпия, полная энтальпия и ротальпия). Опция Static Enthalpy 
предполагает, что вся энтальпия постоянна и однородна в пре­
делах области расчета (область применения -  высоко скорост­
ные невязкие потоки).

Кроме того, пользователь имеет возможность переориенти­
ровать решатель на тепловую или термо-химическую энтальпию 
посредствам выбора одной из опции в Enthalpy. Термо­
химическую энтальпию часто используют для моделирования 
химического взаимодействия потоков с целью исключения 
крупных источников, которые представляют собой температуру, 
с которой идет химическая реакция.

Stagnation Enthalpy

I C heck/F ix  B o u n d a ry  L oca tions 

^ " " /T h e n n o p h y s ic a l M odels a n d  F 

S i T tie rm a l O p tio n s 

—  /L iq u id s  a n d  G a s e s

Si M o lecu la r P ro p e r tie s  

Si T u rb u le n c e  M odels 

H rrf ie rm a i M o n e ljS

Д  S e le c t  A n a ly s is  F e a tu re s  

I C re a te  a n d  Im p o rt G e o m e try

C re a te  a n d  Im p o rt  G rid s  

C h e c k  arid  Fix Grid

Locate Boundaries

Рис. 3.9. Пример задания тепловой модели

Тем не менее для сложных химических реакций с высоко­
уровневыми схемами дифференцирования использование теп­
ловой энтальпии может оказаться более целесообразным.
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3.4.4. Задание контрольных и опорных данных для модели

В процессе решения для каждого материала задается кон­
трольная точка.

C e n t e r

У  Select Aral уз i3 ГеаЩгез 

I Create and Import Geometry 

_ J  Create and Import Grids 

_ |  Check and Hx Grid

_ _ | Locate Boundaries

I Check!Fix Boundary Locations 

^ 7 Thermophysical Models and P 

=1 Thermal Options 

“T - /Liquids and Gases

=1 Molecular Properties 

~ У  Turbulence Models 

У  Thermal Models 

~ У Buoyancy and Body Fo 

~Ш  initialization

■Йм!
-Slai

Monitoring and Fteferen 

Chemical Schem e

feren J

Monitoring and Reference Data 

for AIR

Monitoring Information

Monitoring cell number 45

-  Reference D a t a -------

Pressure l h .e + 0 5 Pa

Reference P ressure
Cel Humber I1
T em perature | 273 К

D ensity КуАЯ*

Рис. 3.10. Задание контрольной ячейки

Она представляет собой ячейку, применительно к которой 
искомые переменные будут выдаваться пользователю в процес­
се счета на дисплей и в файлы *.тп и *.rsi с каждой итерации 
или шага по времени. В качестве контрольной ячейки, как пра­
вило, выбирают ту, в которой ожидается наиболее высокий уро­
вень численной неустойчивости. Выбор ячейки осуществляется 
по номеру или с помощью мыши, после нажатия на кнопку с 
изображением мыши.

Значения действующего давления рассчитываются относи­
тельно опорного давления, действующего в одной из ячеек ка­
кого-либо материала, для каждого материала (константа интег­
рирования в выражении для давления). Для задания места при­
ложения этого опорного давления выбирается грань одной из 
ячеек. Имейте в виду, что если ваша модель имеет граничное
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условие по давлению, то значение опорного давления для моде­
ли становится не важным.

Помимо всего, через папку Liquids and Gases можно осуще­
ствить:

-  ввод ускорения внешних потенциальных полей и внеш­
ние нагрузки на область потока,

-  ввод начальных условий,
-  задание химических компонент.
Пример задания параметров воздействия внешнего поля 

(земного тяготения) описан в Методологии, а алгоритм задания 
представлен в гл. 15 Руководства пользователя.

Программа STAR-CD использует свою внутреннюю интел­
лектуальную процедуру формирования начальных условий за­
дачи, которая имеет достаточно высокий коэффициент сходимо­
сти с результатами стационарных расчетов. Но в ряде случаев, 
более целесообразным может оказаться задание начального по­
ля расчетных переменных в виде постоянной для всей расчетной 
области величины или же задание неравномерного распределе­
ния поля расчетных величин по области потока. Все это реали­
зуется через панель Initialization и более детально описывается в 
гл. 7 Руководства пользователя.

3.4.5. Задание свойств дополнительных скаляров

Дополнительные скаляры (химические добавки) задаются 
для всех потоков жидкости модели снова с использованием па­
нели Molecular Properties Молекулярные свойства дополнитель­
ных скаляров задаются для каждого скаляра безотносительно 
материала, так как каждый скаляр может одновременно присут­
ствовать как в одной, так и в нескольких жидкостях. Тем не ме­
нее начальное распределение и нагрузки, задаваемые через пап­
ки Binary Properties и Initialization, для каждого скаляра задают­
ся в зависимости от материала.
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В программе имеется база данных по химическим добавкам 
для нескольких наиболее часто используемых веществ. Если 
необходимо активизировать эти свойства, необходимо выбрать 
это вещество в просмотровом списке Data Base и щелкнуть по 
кнопке Define Properties from database. Если в расчете необхо­
димо учесть влияние свойств скаляра на расчетные свойства 
жидкости, то в строке Influence необходимо состояние скаляра 
из пассивного перевести в активное -  нажав Active. Стоящая по 
умолчанию опция Passive подразумевает, что скаляр является 
пассивным и его свойства никакого влияния на поток не оказы­
вают.

Если свойства основной жидкости описывались с помощью 
полинома, то свойства каждого активного скаляра должны зада­
ваться аналогично. Доступ к диалоговой панели Polynomial 
Function Definition осуществляется нажатием на кнопку Define 
Polynomials.

Если свойства задавались вручную, то их применение осу­
ществляется с помощью кнопки Define/Modyfy Scalar.

3.4.6. Задание свойств для среды  -  твердое тело

Возможен вариант, когда материал расчетной области явля­
ется не жидкостью а твердым телом, в таком случае для задания 
его свойств будет использоваться панель Solids. Для твердого те­
ла необходимо задать следующие свойства: плотность, теплопро­
водность и теплоемкость. Так же имеется опция задания тепло­
проводности и теплоемкости с помощью пользовательской под­
программы. Если для расчета необходимо принять во внимание 
процесс излучения через твердое тело, а так же радиационные 
свойства (поглощение и рассеяние), то опции для их активизации 
можно задать через панель Solids > Radiative Properties. Е1осле 
задания свойств необходимо нажать на кнопку Apply.

Как и для жидкостей, для твердых тел так же задается кон­
трольная ячейка через панель Solid > Monitoring and Reference
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Data. При этом следует убедиться в том, что эта ячейка дейст­
вительно принадлежит области твердого материала. Температу­
ра в твердом теле рассчитывается так же относительно исходной 
температуры, задаваемой через эту же панель.

По аналогии с жидкостями, для твердых тел так же может 
быть задано начальное распределение расчетных величин. Па­
нель Solids> Initialization предлагает опцию для задания на­
чального распределения температурного поля. При этом поле 
может быть как постоянным, так и неравномерным по коорди­
натам области решения. Для задания неравномерного распреде­
ления поля начальных температур пользователь может восполь­
зоваться просмотровой панелью или подпрограммой пользова­
теля.
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4. НАЧАЛЬНЫЕ УСЛОВИЯ

Термин «начальные условия» относится к величинам, при­
писываемым зависимым переменным во всех узлах сетки до на­
чала расчётов. Их значение зависит от типа рассматриваемой 
задачи:

• При использовании нестационарных течений эта инфор­
мация имеет явное физическое значение и будет влиять на ход 
решения. Поэтому ей необходимо уделить большое внимание. 
Иногда бывает так, что эффект начальных условий ограничива­
ется этапом запуска, что не представляет интереса (как, напри­
мер, в периодических во времени течениях). Тем не менее реко­
мендуется быть осмотрительным при задании начальных усло­
вий по причинам, пояснённым ниже.

• При расчёте стационарного течения итерационным спо­
собом начальные условия обычно не влияют на окончательное 
решение (за исключением редких случаев, когда решение имеет 
множество значений), но могут определять его успешность и 
скорость сходимости. Некорректное задание начального поля 
или, для переходных задач, резкие изменения граничных усло­
вий предъявляют жёсткие требования к численному алгоритму 
при подстановке в уравнения конечных объёмов. В результате 
могут понадобиться следующие особые начальные меры, чтобы 
обеспечить численную устойчивость:

-  использование необычно малых временных шагов при 
расчётах неустановившихся течений;

-  использование малых коэффициентов нижней релаксации 
в итерационных решениях.

Особые рекомендации относительно этих действий содер­
жатся в разделе «Контроль за численным решением». В любом 
случае, увеличение времени расчётов может быть нежелатель­
ным побочным эффектом. Для установившихся и псевдо- 
нестационарных вычислений программа имеет встроенную про­
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цедуру инициализации (задания начальных условий), которая 
применяется при любой инициализации пользователем пере­
менных течений. Более подробно это обсуждается в разделе 
«Инициализация потока» в гл. 7 Методологии. Большинство 
задач можно запустить полностью полагаясь на эту процедуру. 
Тем не менее необходимо уделить внимание задаваемым значе­
ниям характерных линейных размеров и максимальной ожидае­
мой скорости в поле течения, т.к. эти значения важны для ини­
циализации. Пользователю рекомендуется рассчитать задачу 
при нулевой итерации, а затем уточнить поля начальных скоро­
стей и давлений, прогнозируемые STAR-CD. После этого может 
понадобиться точная настройка значения характерного линей­
ного размера. В особо сложных случаях придётся пренебречь 
инициализацией давления, или даже всем процессом инициали­
зации, используя подходящие опции контроля решения. В этом 
случае пользователь должен надеяться на большую нижнюю 
релаксацию или очень малые шаги по времени, чтобы запустить 
решение.
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5. ОПИСАНИЕ ГРАНИЦ

Как говорилось в разделе «Пространственное описание и 
дискретизация объёмов», определение и описание границы тес­
но связано с генерацией сетки конечных объёмов, т.к. геометрия 
границы определяется поверхностями внешних ячеек. Кроме 
того, правильное задание граничных условий часто представля­
ет наибольшую трудность при создании модели. Проблемы час­
то возникают при выполнении следующих действий:

-  определения соответствующего типа условия;
-  задания соответствующего сочетания типов границ;
-  задания соответствующих граничных величин.
Эти действия, в свою очередь, связаны с начальным зада­

нием границ.

5.1. Положение границы

Трудности при определении положения границы обычно 
возникают, когда не полностью известны параметры потока, 
например на выходах. Рекомендуемое решение при снижении 
степени точности — размещать границы в следующих местах:

а) в областях, где параметры известны, если это возможно;
б) в таких местах, где может быть применена опция Выход 

{Outlet) или Давление {Prescribed Pressure) (см. гл. 5, 16 Мето­
дологии)',

в) там, где мала вероятность того, что аппроксимации, при 
определении граничных условий, будут распространяться вверх 
по потоку.

Особенно важно стараться избегать следующих ситуаций:
1. Граница проходит через основную зону рециркуляции.
2. В переходных, околозвуковых или сверхзвуковых сжи­

маемых течениях выходная граница размещена в местах, где 
течение не является сверхзвуковым.
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3. Неправильное сочетание граничных условий. Например:
а) разнообразные границы на выходе -  если не имеется 

дальнейшей информации о разделении течения на выходах;
б) заданные разделённые выходы потока с заданными вы­

ходными границами массы в том же потоке;
в) сочетание заданного давления с условиями разделения 

потока на выходе.

5.2. Граничные условия

Другой источник потенциальных трудностей -  определение 
граничных величин, когда необходимо ввести уже известные 
граничные условия, например, на границе заданного входящего 
потока или на «входной» границе. Основные моменты, которые 
нужно помнить в данной ситуации:

• Все уравнения переноса, которые необходимо решить, 
включая уравнения переноса турбулентности, в случае их ис­
пользования, требуют задания их граничных величин.

• Неверное задание граничных величин может привести к 
ошибочному результату или в крайнем случае к численной не­
устойчивости.

Следующие рекомендации могут быть сделаны относи­
тельно каждого типа границы:

1. Заданное течение. Здесь следует позаботиться о сле­
дующем:

а) Задавайте реалистичные значения всем зависимым пере­
менным, включая параметры турбулентности, а также вспомога­
тельным величинам, таким, как плотность.

б) Убедитесь, что если это единственный используемый 
тип границы, то выполняется условие общей непрерывности. 
(STAR-CD примет случайный дисбаланс массы до 5%, исправ­
ляя его путём подгонки параметров потока на выходе. Если дис­
баланс превысит эту цифру, появится сообщение об ошибке.)
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2. Выход. Основные моменты, которые необходимо учиты­
вать для этого типа границы, следующие:

а) По возможности, необходимо задавать границы в облас­
тях, где течение направлено вовне; а также понимать, что если 
происходит втекание, оно может спровоцировать неустойчи­
вость численного решения и/или ошибки.

б) Если задана более чем одна граница данного типа, необ­
ходимо задать либо разделение потока между ними, либо соот­
ношение потока массы на выходе в каждом положении.

в) «Заданное разделение» выходов неприменимо к задачам, 
где потоки на входе не фиксированы, например:

-  в сочетании с граничными условиями давления,
-  в случае переходных сжимаемых течений.

3. Заданное давление. Основные меры предосторожности:
а) Лучше задавать относительные, а не абсолютные давле­

ния.
б) Если вероятен поток на входе, задать реалистичные гра­

ничные значения температуры и массовые доли. Также реко­
мендуется задавать параметры турбулентности косвенно, через 
интенсивность турбулентности и масштаб, или путём экстрапо­
лирования их из величин внутри расчётной области.

4. Условия торможения. Рекомендуется использовать для 
границ, лежащих внутри больших ёмкостей, где параметры по­
тока в расчётной области не сильно влияют на свойства.

5. Циклические границы. Такие границы всегда появляют­
ся парами. Основные советы таковы:

а) Накладывайте эти условия только при соответствующих 
обстоятельствах. Двумерные осесимметричные течения с вих­
рями -  хороший пример уместного применения этих условий.

б) для осесимметричных течений используйте разностные 
схемы CD/UD, чтобы использовать максимальный уровень цен­
тральных разностей в тангенциальном направлении (фактор пе­
ремешивания по умолчанию -  0,95 (см. тему “Miscellaneous
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Controls” («Разнообразные средства управления») из раздела 
Help в STAR-CD).

6. Плоскости симметрии. Рекомендуется использовать 
это условие для двумерных осесимметричных течений без вих­
рей.

7. Проходные границы свободного потока. Это условие 
следует использовать только для моделирования сверхзвуковых 
свободных потоков.

8. Переходные волновые проходные границы. Это условие 
нужно использовать только в задачах, касающихся переходных 
сжимаемых потоков.
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6. КОНТРОЛЬ НАД ЧИСЛЕННЫМ РЕШЕНИЕМ

Надлежащий контроль над процессом численного решения, 
применённый к уравнениям потока, очень важен для приемле­
мой эффективности вычислений, а иногда и для того, чтобы во­
обще получить решение. Иногда средства контроля над процес­
сом решения сильно зависят от конкретных используемых чис­
ленных методов, так что нельзя дать каких-либо универсальных 
инструкций. Таким образом, рекомендуемые установки разли­
чаются в каждом конкретном случае, в зависимости от выбран­
ного алгоритма и условий его применения.

6.1. Выбор процедуры решения

Основной выбор должен основываться на правильной оцен­
ке природы потока, и процедура решения будет:

-  или нестационарным расчётом, начиная с правильно оп­
ределенных начальных и граничных условий и заканчивая но­
вым состоянием через ряд дискретных шагов по времени,

-  или установившимся решением, где модель не изменяю­
щегося течения при заданном наборе граничных условий дости­
гается путём ряда численных итераций.

PISO, SIMPLE и SIMPISO -  три альтернативные процедуры 
решения, имеющиеся в пакете STAR-CD. PISO обязателен для 
нестационарных течений и может иногда использоваться для 
стационарных, в случаях, где существует сильное взаимодейст­
вие между зависимыми переменными, например течения, обу­
словленные естественной конвекцией. SIMPLE -  алгоритм, на­
строенный по умолчанию для стационарных решений, и в 
большинстве случаев работает хорошо. Однако при особо силь­
ном искажении сетки иногда для лучшего результата может ис­
пользоваться SIMPISO.

Когда существуют сомнения относительно того, имеет ли 
рассматриваемая задача стационарное решение, или когда
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сложно достичь сходимости на итерациях, лучше выполнять 
расчёты, используя опцию нестационарного расчёта.

6.2. Расчёт переходных процессов
с использованием алгоритма PISO

Как говорится в разделе «Алгоритм PISO» в гл. 7 Методоло­
гии, на каждом шаге по времени (шаге итерации) PISO создаёт 
предиктор, вслед за которым создаётся ряд корректоров, при ко­
тором системы линейных уравнений решаются итерационно для 
каждой основной зависимой переменной. Решения относительно 
количества корректоров и внутренних итераций (далее называе­
мых «свипами» во избежание путаницы с внешними итерациями, 
выполняемыми в режиме стационарного решения) принимаются 
внутренне, на основании ошибки при операторе расщепления и 
внутренних уровней невязок соответственно, согласно заданной 
точности и верхним пределам. Значения допустимых отклонений 
решателя, максимальных корректоров и «свипов», заданные по 
умолчанию, представлены в табл. 6.1. Как правило, настройка 
этих параметров пользователем требуется лишь в исключитель­
ных случаях, которые обсуждаются ниже.

Таблица 6.1. Н астройка стандартных контрольны х параметров  
для расчёта неустановившихся течений с использованием P IS O

Параметр
Переменная

Скорость Давление Турбулент­
ность

Энталь­
пия

Массовая
доля

Допустимое
отклонение
решателя

0,01 0,001 0,01 0,01 0,01

Максимальное
количество
внутренних
итераций
(«свипов»)

100 1000 100 100 100

Множитель релаксации для коррекции давления = 1,0

Предел корректора = 20
Допустимая невязка на шаге корректора = 0,25
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Оставшийся ключевой параметр в расчётах нестационарных 
течений с использованием PISO -  это шаг по времени 51. Обычно 
он определяется посредством анализа точности и может варьиро­
ваться в процессе вычислений. В идеале шаг должен быть того же 
порядка величины, что и наименьшее характерное время 5tc для 
конвекции и диффузии, т. е. в большинстве случаев можно рабо­
тать с 8/ ~ 508/6 и при этом получать приемлемую точность по 
времени. Величины, сильно превышающие это значение, могут 
привести к ошибкам и численной неустойчивости, тогда как 
меньшие значения приведут к увеличению времени счета.

В процессе расчётов могут быть достигнуты максимально 
допустимые значения величин, представленные в табл. 6.1, в 
этом случае появятся сообщения, касающиеся данного эффекта. 
Более вероятно, что подобные сообщения будут появляться на 
этапе запуска, однако это допустимо и позже, если в конечном 
итоге они будут появляться лишь иногда или перестанут появ­
ляться вовсе и прогнозы будут выглядеть обоснованно. Если тем 
не менее подобные предупреждения будут продолжать появ­
ляться, необходимо принять корректирующие меры.

Это могут быть:
• Уменьшение шагов по времени, скажем, на начальный 

множитель, равный 2, -  если это исправит ситуацию, значит, 
причина была просто в чрезмерно большом 51.

• Увеличение максимально допустимых значений «свипов» 
-  если первое средство не поможет. Стоит попытаться это сде­
лать, но только применительно к переменным, чьи максимально 
допустимые значения были достигнуты. Напомним: будут уме­
стны изменения в 2 раза.

• Нижняя релаксация коррекции давления -  значение 0,8 
для этой величины, с использованием PISO, может быть полезно 
в некоторых трудных случаях (например, при сильном искаже­
нии сетки или для потоков с числом Маха, близким к единице).
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• Допустимое отклонение шагов корректора -  может быть 
установлено более низкое значение, но необходимо сначала про­
консультироваться с представителями CD Adapco Group.

6.3 Расчёт устойчивых состояний 
с использованием алгоритма PISO (метод итераций)

Когда PISO работает в этом режиме, допустимые отклонения 
внутренних невязок уменьшаются, и для всех переменных, кро­
ме давления, температуры и массовой доли вводится нижняя 
релаксация. Однако при расчетах течений, обусловленных есте­
ственной конвекцией, нижняя релаксация может понадобиться и 
для последних двух переменных. Стандартные значения для 
этих параметров, заданные по умолчанию, и предельные значе­
ния «свипов» те же, что при нестационарном режиме. Они даны 
в табл. 6.2.

Таблица 6.2. Н астройка стандартных контрольны х параметров  
для расчёта итерационных течений с использованием P IS O

Параметр
Переменная

Скорость Давление Турбулент­
ность

Энталь­
пия

Массовая
доля

Допустимое
отклонение
решателя

ОД 0,05 0,1 0,1 0,1

Максимальное 
количество внут­
ренних итераций 
(«свипов»)

100 1000 100 100 100

Множитель
релаксации 0,7 1,0 0,7 0,95 1,0

Предел корректора = 20

Правильная настройка этих параметров приведёт к почти 
монотонному убыванию глобальных невязок в процессе вычис­
лений, в зависимости от плотности сетки и других факторов.
Если после этого одна или более глобальных невязок не умень-
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шатся, необходимо принять меры по устранению причины. В 
некоторых случаях переменные, являющиеся причиной непо­
ладки, можно определить по поведению глобальных невязок.

Основные меры, которые могут быть предприняты:
• Уменьшение множителя (множителей) релаксации. 

Уменьшение должно быть постепенным от 0,1 до 0,05 и приме­
нено к скоростям, если проблема заключается в импульсе и/или 
массовых невязках.

• Увеличение невязок решателя. Как и для неустановивше- 
гося течения, может оказаться полезным, особенно в отношении 
допустимых отклонений давления и его важности для решения 
потока. Двукратное уменьшение должно показать, будет ли эта 
мера действенной.

• Увеличение максимально допустимого количества «сви­
пов». Если появляются предупреждающие сообщения о том, что 
предел «свипов» достигнут и меры 1 и 2 не помогают, стоит 
увеличить пределы переменных, являющихся причиной непо­
ладки.

• Нижняя релаксация плотности и эффективной вязкости, 
следует применять при больших вариациях, например в случае 
сжимаемых потоков, горения, смеси различных газов. Колеба­
ния эффективной вязкости могут привести к турбулентному те­
чению и потоку неньютоновой жидкости, а могут быть таким 
образом ослаблены.

6.4. Расчёты устойчивых состояний 
с использованием алгоритма SIMPLE

Как отмечалось ранее, контрольные параметры, доступные 
в SIMPLE, похожи на те, что имеются в PISO, за исключением 
того, что всегда используется одна фаза корректора и нижняя 
релаксация давления. Стандартные настройки (задаваемые по 
умолчанию) представлены в табл. 6.3.
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Если не удаётся получить решения со стандартными значе­
ниями, меры, которые необходимо предпринять для исправле­
ния ситуации, существенно не отличаются от тех, которые пред­
ставлены в разд. 6.3 (для расчётов стационарных течений с PISO 
в итеративном режиме). Однако здесь уменьшение коэффициен­
та релаксации для давления является дополнительным способом 
преодоления неустойчивости решения. Стоит отметить, что 
стандартное значение этого множителя уже низкое (0,3), поэто­
му рекомендуется дробное уменьшение не более чем на 50%. 
Если при сильном искажении сетки потребуются значения, 
меньшие 0,1, тогда следует либо смягчить ее искажение, либо 
использовать алгоритм SIMPISO.

Таблица 6.3. Н астройка стандартных контрольны х параметров  
для расчёта итерационных течений с использованием S IM P L E

Параметр
Переменная

Ско­
рость Давление Турбу­

лентность Энтальпия Массо­
вая доля

Допустимое
отклонение
решателя

ОД 0,05 0,1 0,1 0,1

Максимальное 
количество внут­
ренних итераций 
(«свипов»)

100 1000 100 100 100

Множитель
релаксации 0,7 0,3 0,7 0,95 1,0

6.5. Расчёт стационарных течений 
с использованием алгоритма SIMPISO

Процедура SIMPISO, как говорится в разделе «Алгоритм 
SIMPISO», в гл. 6 Методологии, содержит дополнительные ме­
ры для устранения эффекта неортогональности сетки при расчё­
тах давления. Обычно он сопровождается дополнительным 
множителем нижней релаксации, как показано в табл. 6.4, кото­
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рый при необходимости может быть снижен с декрементом 
~ 0,05. Для ортогональных или почти ортогональных сеток, 

SIMPISO возвращается к SIMPLE.

Таблица 6.4. Н астройка стандартных контрольны х параметров  
для расчёта итерационных течений с использованием S IM P IS O

Параметр
Переменная

Скорость Давление Турбулент­
ность Энтальпия Массовая

доля

Допустимое
отклонение
решателя

ОД 0,05 0,1 0,1 0,1

Максимальное
количество
внутренних
итераций
(«свипов»)

100 1000 100 100 100

Множитель
релаксации 0,7 0,3 0,7 0,95 1,0

Множитель 
релаксации 
для коррекции 
давления

- 0,8 - - -

6.6. Влияние ошибок округления

Были приложены большие усилия, чтобы снизить воспри­
имчивость STAR-CD к влиянию машинных ошибок округления, 
но всё же могут возникать проблемы при работе на 32-битных 
машинах. Они обычно проявляются как ошибки итеративных 
решателей при конвергенции или в крайнем случае при дивер­
генции, ведущей к ошибке арифметического переполнения.

Если возникшие трудности связаны с подобными пробле­
мами, настоятельно рекомендуется переключиться в режим рас­
чётов с двойной точностью. Инструкции о том, как это сделать, 
содержатся в Руководстве по установке. Как правило, стоит 
избегать генерации очень малых значений объёмов и поверхно­
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стей ячеек, работая с разумными единицами длины. Или же сто­
ит задать другие единицы измерения при сохранении соответст­
вующих безразмерных величин, таких, как Re и Gr.

6.7. Выбор решателя линейных уравнений

STAR-CD предлагает два типа прекондиционеров для реше­
ния линейных уравнений методом сопряжённых градиентов: 
один полностью векторизуется, второй численно превосходит 
первый, но векторизуется только частично. Поэтому первый 
(называемый «векторным» решателем) рекомендуется исполь­
зовать, когда программа работает на векторных машинах (таких, 
как GRAY-CD), второй (называемый «скалярным» решателем) -  
когда STAR-CD работает на скалярных машинах (таких, как ра­
бочие станции).
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7. МОНИТОРИНГ П РО Ц ЕС С А  РЕШЕНИЯ

В гл. 8 Руководства пользователя в разделе, посвященном 
«Непрерывному выводу», дано подробное описание информа­
ции, получаемой при вычислениях на каждой итерации и шаге 
по времени и используемой для мониторинга и контроля. Она 
включает в себя:

• значения всех зависимых переменных на заданном поль­
зователем участке мониторинга. Следует быть внимательным 
при выборе участка, особенно при расчётах стационарных тече­
ний. В идеале это должен быть чувствительный участок тече­
ния, где приближение к стационарному состоянию, вероятно, 
будет самым малым, например в зоне рециркуляции. При расчё­
те неустановившихся течений информация будет иметь другое 
значение и следует использовать другие критерии выбора. На­
пример, участок может быть выбран для подтверждения ожи­
даемого периодического поведения переменных течения.

• нормализованные глобальные невязки Иф для всех ре­

шаемых уравнений. Кроме невязок для коэффициента диссипа­
ции турбулентности (см. гл. 7, раздел «Завершающие тесты» 
Методологии), эти невязки используются для оценки хода про­
цесса и сравнения итерационных вычислений для решения ста­
ционарных и псевдо-нестационарных течений. На начальных 
стадиях вычислений нелинейности и взаимозависимости урав­
нений могут явиться причиной немонотонного убывания невя­
зок. Если эти колебания будут продолжаться после, скажем, 50 
итераций, это может быть показателем наличия проблем.

• глобальные скорости изменения Сф для всех решаемых

уравнений. Они используются при расчётах неустановившихся 
потоков и не являются показателем незавершенности решения; 
они, скорее, просто показывают общие скорости изменения со­
храняющихся величин (массы, импульса, энергии, и т.д.). Их
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толкование и полезность будут в итоге зависеть от конкретных 
обстоятельств их применения.

Важно помнить, что доведение нормализованных невязок 
до предопределённого допустимого значения -  необходимое, но 
недостаточное условие сходимости по двум причинам:

1) используемая практика нормализации (представленная в 
Приложении А Методологии) может не подходить для приме­
нения;

2) также необходимо, чтобы величины, представляющие 
интерес в решении, стабилизировались до приемлемого уровня. 
Если есть сомнения в отношении какой-либо причины, реко­
мендуется снизить допустимое отклонение и продолжить вы­
числения.

Из вышесказанного следует, что при оценке хода и завер­
шённости итерационных расчётов стационарного течения боль­
шое внимание уделяется глобальным невязкам. Эти величины 
являются прямыми показателями степени сходимости отдель­
ных систем уравнений и, следовательно, важны как для завер­
шающих тестов, так и для выявления проблемных участков те­
чения, в случае, когда сходимость не достигнута. Более того, 
они имеют явный физический смысл. Например, невязки энер­
гии являются (нормализованным) показателем порядка, с кото­
рым преобладающие поля удовлетворяют сохранению энергии. 
Аналогичным образом можно объяснить и другие невязки.
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8. ОЦЕНКА И П РОВЕРКА  МОДЕЛИ

STAR-CD предлагает набор средств, позволяющих оценить 
точность и эффективность всех аспектов процесса построения 
модели. При прохождении этапов моделирования, обсуждаемых 
ранее, пользователь должен воспользоваться этими возможно­
стями и убедиться, что:

1. Геометрия сетки согласуется с тем, что предполагалось 
смоделировать. Это значительно облегчается встроенными гра­
фическими возможностями, которые позволяют:

а) поворачивать,
б) перемещать,
в) уменьшать
г) увеличивать сетку.
Это позволяет пользователю увидеть сетку с любой точки 

в правильной трехмерной проекции. Частые выведения сетки 
на экран на этапе генерации очень полезны для проверки её 
точности и поэтому очень рекомендуются, особенно для задач 
со сложной геометрией. Лучше, если такие геометрии разделя­
ются на удобные части, для каждой из которых можно отдельно 
создать сетку, а потом проверить визуально.

2. Материалы с разными физическими свойствами пра­
вильно размещены в сетке. Это можно проверить визуально, 
используя встроенную схему дифференциации цвета. Или же 
можно отдельно нарисовать сетку для каждого материала. Точ­
ные значения заданных характеристик можно проверить через 
окно вывода информации.

3. Для проверки корректности задания граничных условий 
необходимо рассмотреть сетку с таких позиций, чтобы было 
видно:

а) расположение границы,
б) тип границы,
в) схему использованных условий (например, скоростей на 

входе).
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Более полную информацию по заданным граничным вели­
чинам можно получить в окне вывода информации.

4. Следует также проверить начальные условия, особенно 
для нестационарных задач и начальных полей, заданных через 
подпрограммы пользователя; для этого нужно запустить STAR 
для нулевых итераций/шагов по времени и нарисовать соответ­
ствующие поля переменных.

Проверка расчётов

Когда подготовка модели завершена, следующий шаг -  это 
запуск решателя STAR и проверка численных расчётов. Резуль­
таты могут быть представлены различным образом, подробно­
сти содержатся в гл. 9 Руководства пользователя. Кратко, вы­
ходная информация и/или графики могут включать:

• Значения полей всех первичных переменных на внутрен­
них и граничных узлах;

• Значения вышеуказанных величин, полученные интер­
поляцией, в случайных, задаваемых пользователем точках или 
поверхностях внутри расчётной области;

• Поверхностные коэффициенты переноса тепла и мас­
сы, а также силы; и, кроме того, значения безразмерной коорди­
наты у  для пристеночных узлов сетки;

• Глобальные величины, такие, как суммарные компонен­
ты силы (например, тормозящая или подъёмная сила), дейст­
вующие на погружённые тела, и их безразмерные прототипы, 
общие энергобалансы и т.д.

Важно тщательно изучить эту информацию и убедиться, 
что расчёты правильно выполнены и дают разумные результаты. 
В частности, пользователь должен убедиться, что:

• Проверено правдоподобие внутренних полей и анало­
гичным образом проверены глобальные величины;
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• Для расчётов турбулентных течений пристеночные зна­

чения у + лежат в рекомендуемом интервале (30-100) в участ­

ках, где это важно. В случае расчётов с участием двухслойной 
модели необходимо убедиться, что сетка в пристеночном слое 
достаточно густая;

• Величина ошибок численной дискретизации (простран­
ственной и, где необходимо, временной) определена, и при не­
обходимости приняты меры по их уменьшению до приемлемого 
уровня.

Из всех вышеперечисленных задач последняя наиболее 
сложна, т.к. её невозможно решить путём простых расчётов. Для 
этого требуется следующее:

-  надёжный способ оценки ошибок дискретизации. В на­
стоящее время для этого нужно повторить расчёты с более мел­
кими ячейками и меньшими шагами по времени (строго говоря, 
это должно быть сделано независимо) и обратить внимание на 
участки существенного изменения решения;

-  стратегия для изменения сетки или шагов по времени, 
чтобы сократить ошибки. Эта корректировка выполняется вруч­
ную.

В идеале процесс исправления ошибок должен продол­
жаться до тех пор, пока изменения не достигнут приемлемого 
уровня. На практике такой подход может быть неосуществим, 
особенно для трёхмерных задач со сложной геометрией, в силу 
больших расходов на подготовку и вычисления.

Альтернативный способ обнаружить ошибки округления -  
изменить схему пространственной дискретизации и посмотреть, 
как это повлияет на решение. Опции второго порядка или их 
сочетания, доступные в STAR-CD, обычно выдают наименьшие 
численные ошибки.

61



9. ПОСТ-ПРОЦЕССИНГ ДАННЫХ (О Б РА Б О ТК А  РЕЗУЛЬТАТОВ)

9.1. Введение

Обработка результатов является важнейшей частью любого 
CFD расчета. Учитывая сложность и разную природу течений, 
исследуемых в STAR-CD, очень важно для пользователя иметь 
общее представление о доступных в PROSTAR средствах пост- 
процессорной обработки данных. Эти средства используются на 
обеих пре- и пост-процессорной стадиях процесса моделирова­
ния. Их можно разделить на три следующие категории:

1. Операции с базой данных для образования групп ячеек и 
узлов.

2. Операции для графического отображения ячеек, узлов 
или данных для стенок.

3. Функции характеристик изображения, которые опре­
деляют тип изображения, угол просмотра, опции изображения, 
режим работы дисплея и т.д.

Анализ результатов расчета, полученных из STAR, можно 
проводить двумя основными способами:

1. Путем просмотра распечатки результатов, получаемых в 
ходе вычислений, и сохранения их в выходной файл с расшире­
нием (,шп). Данные представляются в табличной форме;

2. Путем графического вывода результатов на экран, при­
меняя средства постпроцессорной обработки, доступные в 
PROSTAR. Это делается в комбинации с уже упомянутыми 
функциями изображения выбором различных опций на одной из 
панелей STAR GUI. Доступны также дополнительные средства 
в меню Post, Graph или Animation Module.

9.2. Загрузка данных и настройка их вывода

Для проведения анализа результаты STAR-вычислений мо­
гут быть отображены на экране в виде следующих типов изо­
бражений:
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• Векторное изображение поля скоростей
• Контурные изображения скалярных величин (см. рис. 9.1)
• Поверхности изолиний скалярных величин
• Контурные и векторные изображения данных стенок
• Траектории частиц
• Графики зависимостей X-У  (см. рис. 9.2)
• Средства анимации изображений

Рис. 9.1. Контурное распределение температур
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Рис. 9.2. Графическое сравнение результатов на разных сетках
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Независимо от того, какая из вышеперечисленных опций 
будет выбрана, существует ряд операций, которые необходимо 
выполнить прежде, чем вывести графическую информацию на 
экран. В основном эти операции запускаются с панелей STAR 
GUIde и иногда в меню Post, расположенном в главном окне 
PROSTAR.

Для пост-процессорной обработки результатов необходимо 
выполнить следующие шаги:

Шаг 1
Пересмотреть всю основную информацию относительно 

вашей модели, «считывая» ее из файла PROSTAR данных моде­
ли (файл с расширением *.mdl,) выбрать маршрут File>Resume 
Model.

Шаг 2
Загрузить результаты вычислений, выполненных STAR для 

этой модели:
-  для стационарных задач результаты хранятся в файле ре­

шения с расширением *.pst;
-  для нестационарных задач результаты обычно сохраня­

ются через определенные интервалы времени в специальные 
файлы пост данных с расширением (*.pstt). PROSTAR позволяет 
осуществлять загрузку этих результатов в соответствии со вре­
менем их получения. Однако файл стандартного решения (* pst) 
также остается доступным и содержит данные о состоянии об­
ласти течения на конечном этапе нестационарного процесса.

Файл результатов *pst содержит поля значений всех рас­
четных переменных. Кроме этого, в нем могут быть сохранены 
дополнительные величины, такие как коэффициенты теплопере- 
носа, значения У4" и т.д. (все это задается с помощью панели 
Analysis Controls'^Output Controls > Analysis Output).

Если выполняется нестационарный расчет, то файл *pst 
содержит поля значений всех расчетных переменных с послед­
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него шага по времени, а промежуточные значения сохраняются 
в отдельном файле с расширением *.pstt. Список переменных, 
подлежащих сохранению, а так же частота их записи в этот 
файл задается пользователем в процессе подготовки расчета.

Для загрузки данных стационарного или нестационарного 
расчета из файлов *.pst или *pstt можно использовать NavCenter:

• Откройте папку Post -  Processing и выберите Load Data;

• В меню Analysis выберите тип данных (стационарные -  
Steady State, нестационарные -  Transient)',

• Для загрузки файла данных нажмите Open Post File;
• Для выбора переменных перейдите на вкладку Data.

I Export Data

Рис. 9.3. Открытие панели Load Data

Шаг 3

Выберите часть модели, для которой будет проводиться 
пост-процессорная обработка данных. Это можно сделать, ис-
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пользуя множество цветных кнопок для выбора. В процессе ре­
шения все величины рассчитываются в центрах ячеек. Именно 
эти данные и записываются в файлы результатов. Визуализация 
результатов может основываться как на значениях в центрах 
ячеек (пункт Cell в меню Data Туре), так и на значениях в вер­
шинах (соответствующий пункт в меню Data Туре называется 
Cell & Wall/Bound (Smooth)), получаемых в результате интер­
поляции.

Значения для граничных 
областей и стенок (пункты 
Boundary> и Wall) отобража­
ются на специальных дву­
мерных ячейках-оболочках 
(shells), автоматически созда­
ваемых PROSTAR. Для за­
грузки данных по давлению:

• В меню Data Туре 
выберите опцию Cell.

• В списке скалярных 
переменных Scalar Data 
выберите переменную Pres­
sure (Давление).

• Для загрузки данных

Рис. 9.4. Пример загрузки данных нажмите Get Data, 
по давлению

• Для перехода к панели визуализации Create Plots нажми­
те красную кнопку Go То Create Plots.

Последнее действие эквивалентно выбору панели Create 
Plots непосредственно в NavCenter.

Шаг 4
Выбор вида отображения данных. Различные способы ото­

бражения результатов собраны на трех основных вкладках:
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3-D Surface (Трехмерное отображение), Section/Clipped (Сече­
ния и разрезы) и IsoSurf (,Изоповерхности). Вкладки Vectors 
и Options содержат элементы настройки формата отображения.

• На вкладке 3-D Surface в меню Options выберите Contour 
(filled) (контуры равных значений с заливкой между ними).

• В меню Edge/Mesh выберите Grid (Отображение линий 
сетки).

• Нажмите Plot to Screen (Отобразить на экране).

N a v ^ P  
C e n t e r

_  Cl ient, and Fix Grid 

_ I ПГЛ1П Rnuridnrlns 

_  Checki'Foc Boundary Location; 

_ I hH.mmfinysirnl МйШЧЯ find l 

_  Du law Euwnlary CUiuiUuns 

_ Analysis Controls 

Chuuk Mudd Setup 

_  Analysis Kre|]aratiDii.rhtuiiniuj| 

“ Post R uccselng 

M Luad Dala 

—В  c reate  Hlots

§  Particle Tracks 

_  Export Data

a rc »  N I Alt f.Ulidfi

Catlap:NawentM
Help

9

sItLA Kn5"") ’“ I

Option Contour (Idled) 

EriguiMusli GVid _ i j

e It Hite j itDstjilt
it. In Ilie__

"Si

Рис. 9.5. Вывод панели Create Plots

Шаг 5
Выберите направление, откуда вы будете смотреть на мо­

дель, и общую ориентацию модели, как обсуждалось в гл. 5 Ру­
ководства пользователя.
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Шаг 6
Загрузите соответствующие пост-процессорные данные в 

память компьютера, для выполнения дальнейших операций с 
ними, вывода графического изображения или печати. Данные 
могут включать:

-  векторные величины, т. е. компоненты скорости или мас­
совые потоки;

-  скалярные величины, например, давление (пьезометриче­
ское, статическое или общее), температуру, параметры стенок 
(например, коэффициенты теплопередачи), геометрическую ин­
формацию (например, координаты узлов для подвижных сеток) 
и так далее.

Средства, с помощью которых организуется доступ к вы­
шеперечисленной информации, находятся на панели Load Data 
графического интерфейса STAR GUIde, расположенной в папке 
Postprocessing, и собраны в группу Data tab.

Помимо средств графического интерфейса STAR GUIde, 
существуют еще две дополнительные возможности по загрузке 
данных, которые реализуются в меню Post, расположенном в 
главном окне PROSTAR: Get User Data. С помощью данной 
диалоговой панели производится полная спецификация выво­
димых данных посредством ввода следующей информации: 
имени файла, места нахождения данных и типов регистров дан­
ных, в которых и будет хранится информация. Окончательно 
входной файл формируется при нажатии на кнопку Apply.

9.3. Пост процессорная обработка изображений

Спецификация изображений

В зависимости от типа данных, сохраненных с помощью 
операций, описанных в секции Данные и настройка их вывода, 
необходимо выбрать опцию Plot option. Соответствующий вы­
бор осуществляется в выпадающем меню Plot Options с левой
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стороны главного окна PROSTAR. Дополнительные опции мож­
но также выбрать в ниспадающем списке на панели меню Plot, 
показанном ниже:

Ниспадающий список, открывающийся из пункта Options, 
предлагает следующие возможности выбора:

1. Опция Geometry является установкой по умолчанию и 
используется для графического вывода геометрии модели и се­
точной структуры.

2. Опция Vector используется для графического отображе­
ния постпроцессорных данных, обладающих и абсолютным зна­
чением, и направлением (например, векторы скорости, векторы 
сил и др.).

3. Опция Contour используется для 
изображения скалярных переменных 
величин (например, давления, темпера­
туры, плотности и т.д.).

4. Средства для получения контур­
ных изображений скалярных величин с 
наложением векторных изображений 
доступны при использовании опции 
Vect+Cont.

5. Опция Isosurface используется для 
изображения поверхностей постоянных 
значений для заданных значений скаляр­
ных переменных величин. Численные 
значения для всех изображаемых изопо­
верхностей должны быть указаны в диа­
логовом окне, которое появится на экра­
не при выборе этой опции. Изоповерхно­
сти могут быть в виде именных наборов 
оболочек или узлов, задаваемых с помо-

Рис. 9.6. Панель меню Plot ЩЬЮ команды PSCREATE.
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Выбор графической опции также может зависеть от типа 
выбранного изображения. Это в дальнейшем будет проиллюст­
рировано на примере, приведенном ниже.

Пример 1
Изображение поля скоростей направленными векторами 

скорости.
1. Сохранить все компоненты вектора скорости (т. с. и. v. w) 

в базе данных программы, выбрав соответствующую опцион­
ную кнопку на диалоговой панели Load Cell Post Data.

2. Выбрать маршрут Plot>Type>Normal для отображения 
каркасного изображения модели (реберной структуры модели).

3. Выбрать маршрут Plot>Options>Vector для получения 
векторного поля скоростей.

Выбор такого вида изображения не всегда удобен, так как 
требует огромного количества одновременно выводимой на эк­
ран информации. В качестве альтернативы можно выбирать 
следующие возможные варианты получения изображений:

• Маршрут Plot>Type>Qhidden для получения графиче­
ского изображения результатов только на видимых поверхно­
стях сеточной модели.

• Маршрут Plot>Type>Ehidden заметьте, что стрелки ско­
рости расцвечиваются на экране в полном соответствии с абсо­
лютными значениями скорости (рис. 9.7, 9.8).

• Маршрут Plot>Type>Section для получения графического 
изображения результатов в указанном сечении модели.

9.4. Вывод изображения на экран

Следующим шагом ваших действий является реальное ото­
бражение заданного изображения на экране. Это выполняется с 
помощью графических опций меню следующим образом:

• Cell Plot -  изображаются данные вычислительной сетки.
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• Wall Plot -  изображаются данные стенок на автоматиче­
ски создаваемых на поверхностях стенок shell-ячейках. Новые 
shell-ячейки должны быть включены в определенное на текущий 
момент множество ячеек до использования этой функции. Ис­
пользование маршрута Options>Vector для стенок позволяет 
получать изображения скорее компонент поверхностных сил, 
чем компонент скорости.

• Vertex Plot -  изображает векторные величины поверх 
изображения узлов.

Пожалуйста, обратите внимание, что опция Cell Plot обыч­
но используется для получения графических изображений узло­
вых результатов, полученных в результате интерполяции дан­
ных. Опция Vertex Plot -  это просто альтернативный способ 
отображения информации подобного рода,

Опция Replot может использоваться на этом этапе до тех 
пор, пока

-  множество баз данных для ячеек, узлов, или shell-ячеек 
стенки остается неизменным при переходе от одного изображе­
ния к следующему;

-  на экране имеется текущее изображение.
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Рис. 9.7. Векторное поле скоростей на поверхности сеточной модели
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Рис. 9.8. Изображение изолинии давления 
на поверхности сеточной модели

9.5. Действия с изображением

С векторными изображениями поля скоростей потока мож­
но выполнять различные действия, используя средства графи­
ческого интерфейса STAR GUIde, доступ к которым осуще­
ствляется на панели Create Plot, расположенной в папке Post- 
Processing. Опции позиции Vectors на этой панели позволяют 
выполнять следующие операции:

• Изменение размера векторов скорости с помощью задан­
ного коэффициента масштабирования (опции Vector Scale),

• Изменение формы стрелок представляющих векторы 
скорости (опции Vector Arrows),

• Интерполяция (отображение) векторов скорости на ре­
гулярную сетку (опции Presentation Grid),

• Уменьшение количества отображаемых векторов на за­
данный коэффициент.

С контурными изображениями скалярных пост-данных так­
же можно выполнять ряд действий, например:

• Уменьшение (разреживание) используемых коэффици­
ентов числа маркировочных знаков, используемых при изобра-
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жении контурных линий, указывая коэффициент масштабирова­
ния, который устанавливается с помощью бегунка Thin Vectors 
в позиции Vectors.

• Изменение цветовой палитры и количества цветов, ис­
пользуемых для полностью окрашенных контурных изображе­
ний или для изображений контурных линий в зависимости от 
установок, заданных командой TERMINAL (см. «Функции выво­
да изображений» в гл. 2 Руководства пользователя). Выполне­
ние этой операции осуществляется в другой позиции под назва­
нием Options.

Кроме того, PROSTAR позволяет изменять текущую таб­
лицу основных цветов, корректируя значения RGB индексов в 
карте цветов (см. «Установка цвета» в гл. 5 Руководства пользо­
вателя). Стандартное сочетание цветов фона и переднего плана 
может быть также изменено на обратное выбором меню 
Plot>Background>Reverse.

9.6. Операции с данными

Утилита O P E R A T E . PROSTAR располагает служебной про­
граммой (утилитой) для выполнения различных операций с мас­
сивами данных для ячеек, узлов, границ и стенок, которая по­
зволяет преобразовывать в алгебраическом смысле массивы ре­
зультатов или геометрических данных, загружаемые из одного 
или более файлов данных. Для активизации этой утилиты необ­
ходимо выбрать маршрут на панели меню Post>Operate, в ре­
зультате чего на экране отобразится диалоговая панель Post Reg­
ister Operations.

Массивы геометрических данных или результатов (по пол­
ной сеточной модели) могут быть сохранены в так называемых 
запоминающих регистрах с номерами от 1 до 6; выбор регистров 
осуществляется в выпадающих списках позиций Register. По 
существу, эти регистры представляют собой не что иное, как
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ячейки памяти. Однако данная утилита OPERATE к тому же по­
зволяет выполнять с ними дальнейшие преобразования.

Обычный процесс выполнения операций с данными с ис­
пользованием этой утилиты может быть разделен на три этапа 
следующим образом:

I. Сохранить данные ячеек и узлов в запоминающие реги­
стры с 1 по 6. Обратите внимание, что:

1) По установленным правилам PROSTAR векторные па­
раметры пост-данных сохраняются в регистры 1, 2, и 3, в соот­
ветствии с их компонентами в направлениях X, Y и Z. Скалярные 
параметры пост данных сохраняются в регистр 4. Это правило 
применяется, когда загрузка данных осуществляется с помощью 
обычных утилит загрузки, таких, как GETCELL.

2) Утилита OPERATE также содержит функции загрузки 
скалярных параметров, которые обладают большей гибкостью 
относительно действий с регистром(ами), в которые загружены 
данные. Ей доступны следующие функции:

Load Cell Data (Загрузка информации в ячейках). По 
своему функциональному назначению подобна операции GET­

CELL -  осуществляет загрузку координат центров тяжести ячеек 
(в локальной системе координат, если требуется), объемов и по­
верхностей (для shell- или baffle-ячеек).

Load Vertex Data (Загрузка информации в узлах).
Load Boundary Data (Загрузка информации на грани­

цах). Осуществляет загрузку координат центров тяжести границ 
(в специальной местной системе координат, если требуется) и 
поверхностей.

Load Wall Data (Загрузка информации на стенках). По
своему функциональному назначению подобна операции GET- 

WALL; осуществляет загрузку координат центров тяжести стенок 
(в специальной местной системе координат, если требуется) и 
поверхностей.
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Load User Data (Загрузка данных пользователя)

3) Обратите внимание, что, хотя выбор запоминающих ре­
гистров для хранения входных данных полностью подчинен 
пользователю, некоторые операции, выполняемые на следую­
щих стадиях (например, получение изображений), предполага­
ют, что правило, данное выше (см. п. I. 1), соблюдено.

II. Выполнить требуемую операцию с данными (векторное 
арифметическое, алгебраическое действие, тригонометрическое 
действие и т.д.). Операнды выбираются из выпадающих списков 
позиций Register с правой стороны от знака равенства «=». При 
нажатии на кнопку Apply, результат действия появится в реги­
стре, выбранном в выпадающем списке позиции Register с левой 
стороны знака равенства, перезаписывая все данные, которые к 
тому времени могли в нем находиться. Доступные операции 
объединены в следующие группы:

Multi-Register. Действия производятся с данными, храня­
щимися в одном или нескольких регистрах, указанных с правой 
стороны знака равенства Результат сохраняется в регистре, ука­
занном с левой стороны знака равенства

Single-Register. То же самое, за исключением того, что 
действия производятся с данными, хранящимися только в одном 
регистре (с правой стороны в списках появляется только один 
регистр).

Scalar/Vector. То же самое, за исключением того, что дос­
тупные действия требуют к спецификациям регистров приплю­
совать постоянное значение. Последнее указывается в специ­
ально предназначенном текстовом окне.

III. Сохранить результат операции (по необходимости). 
Доступны следующие действия:

Put Cell Data. Выполняет действие, обратное действию 
операции Load Cell Data, т. е. текущие данные ячеек, сохранен­
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ные на текущий момент в заданном регистре, записываются об­
ратно в файл результатов в качестве указанных элементов ячеек.

Save to File. Сохраняет текущие данные, сохраненные на 
текущий момент в заданном регистре, в файл (.usr) в двоичном 
или закодированном формате.

Register Keys. Подготавливает pro-STAR к графическому 
отображению

-  содержимого регистров 1-3 как векторных величин (оп­
ция Vector),

-  содержимого регистров 1-6 как параметров потока (оп­
ция Flux). В этом случае, каждый регистр должен содержать 
значение параметра потока для каждой из шести граней задан­
ной ячейки.

Задачей следующего этапа обычно является печать (полу­
чение текстовой информации), анализ или вывод графической 
информации по результатам вышеназванных операций. Некото­
рые возможности проиллюстрированы на следующем примере:

Пример 1
Перенос векторов скорости из расчетной вращающейся 

системы отсчета в неподвижную систему.
1. Загрузить выходные данные STAR выбором маршрута с 

панели меню Plot>Load Static Post File и последующим выбо­
ром требуемого файла с расширением (.pst).

2. Активизировать диалоговую панель Post Register Opera­
tions. Загрузить вычисленную А-компоненту скорости в регистр 
1, выбирая маршрут Load Cell Data>Velocity U-component из 
выпадающего меню позиции Function.

3. Повторить п. 2 для компонент скорости Y и Z, сохраняя 
их в регистры 2 и 3.

4. Полагая, что система вращается вокруг оси Z  в локаль­
ной цилиндрической системе координат с номером 11 со скоро­
стью 3000 оборотов в минуту, пересчитать компоненты скоро­
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сти, хранящиеся на текущий момент в регистрах с 1 по 3, отно­
сительно неподвижной системы отсчета. Чтобы сделать это, вы­
берите маршрут Multi-Register>Reframe (r*w) из выпадающего 
меню позиции Function и затем введите значения для номера 
координатной системы (ICSYS) и скорости вращения (Omega) в 
специально предназначенных для этого текстовых окнах.

5. Построить графическое изображение заново рассчитан­
ных векторов скорости:

а) настроить PROSTAR для вывода графической информа­
ции, находящейся в регистрах 1-3, как векторных величин вы­
брать Register Keys>Vector из выпадающего меню позиции 
Function.

б) выбрать маршрут на панели меню Plot>Options>Vector, 
и затем Cell Plot.

6. Скалярные параметры для контурного изображения мо­
гут храниться только в регистре 4. Поэтому, чтобы создать кон­
турное изображение абсолютных значений скорости, необходи­
мо активировать диалоговую панель Post Register Operations и 
выбрать маршрут Multi-Register>Vmagnitude из выпадающего 
меню позиции Function. При этом абсолютные значения скоро­
сти будут вычислены из данных, хранящихся в регистрах 1-3, 
а результат будет сохранен в регистр 4.

7. Для графического отображения данных выбрать маршрут 
на панели меню Plot>Options>Vector и затем сделать Cell Plot

9.7. Представление результатов для отчета

Помимо графических возможностей, PROSTAR располага­
ет средствами для обработки и представления выходных резуль­
татов для включения их в отчетный документ в текстовом виде 
(табличная форма численных значений результатов). Сущест­
вуют следующие возможности:

1. Отображение на экране результатов в выбранных на 
текущий момент ячейках или узлах. Выбрать маршрут на пане-
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ли меню Lists>Post Registers для активизации панели диалога 
Post Register Data. Содержимое всех пост-регистров отобража­
ется в прокручивающемся списке в порядке возрастания номе­
ров ячеек. Существует также возможность выбора распечатки 
списка всех данных или только данных в текущих ячейках или 
текущих узлах (помеченных в списке звездочкой в колонке Set). 
Выбор осуществляется просто нажатием на кнопки Show All 
Data или Show Set Data Only, соответственно.

Обратите внимание, что кнопка Update List служит для то­
го, чтобы можно было обновлять список результатов в случае, 
если изменения массивов данных или данных, находящихся в 
пост регистрах, сделаны вне диалоговой панели Post Register 
Data.

С панели диалога обеспечивается также доступ к операци­
ям сортировки, которые позволяют организовать выдачу резуль­
татов в порядке убывания значений отдельных искомых вели­
чин. Имеется возможность сортировки по действительным зна­
чениям или по абсолютным значениям, по значениям (скаляр­
ных) величин, хранящихся в регистре 4. Кнопка Unsort отменя­
ет действие операции сортировки результатов.

2. Интерполяция и отображение на экране выбранных те­
кущих результатов в определенных пользователем точках рас­
четной области (команда SENSOR). Эти точки определяются в 
одном или в нескольких узлах, а значения в них получаются ин­
терполяцией значений в ближайших ячейках. Узлы, используе­
мые для этой цели, не должны быть связаны с какими-либо 
ячейками сеточной модели; они только должны находиться в 
пределах поля течения. Вычисленные таким образом значения 
могут быть полезны для сравнения численного расчета с экспе­
риментальными результатами, полученными в этих точках.

3. Отображение на экране численного (полученного ин­
терполяцией) значения переменного параметра в некоторой 
точке, указав ее местоположение на поверхности контурного
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изображения с помощью графического. Выбрать опцию PCross 
в меню Post.

4. Суммирование и отображение на экране суммарных ре­
зультатов, усредненных, минимальных и максимальных значе­
ний и их месторасположения. Применяется к массивам резуль­
татов, хранящихся на текущий момент в пост-регистрах.

5. Отображение результатов, полученных интерполя­
цией известных значений, в плоскости сечения команда 
SPRINT). Данные в ячейках считаются постоянными в пределах 
каждой ячейки, тогда как результаты в узлах интерполируются 
линейно на нужную плоскость.

6. Интегрирование результатов по определенной пользо­
вателем плоскости сечения.

7. Вычисление аэродинамических коэффициентов коман­
да ACOEFF.

8. Вычисление массы потока, проходящего через грань 
индивидуальной ячейки или через грани множества ячеек. Вы­
брать маршрут на панели меню Post>Flux Sum, затем выбрать 
одну из опций в выпадающем списке. Требуемые грани можно 
указать индивидуально с помощью графического курсора (Pick 
Cell), или группой (Zone), рисуя полигон вокруг них.

Все графические изображения результатов можно также 
отсылать в файл, чтобы позже иметь возможность просматри­
вать и анализировать их.

9.8. Отображение и копирование результатов

PROSTAR обеспечивает пользователя командами для ото­
бражения (mapping) и копирования массивов результатов из су­
ществующей сеточной модели (т. е. расчетной сеточной облас­
ти) на любой произвольный объем или поверхность. Эти коман­
ды можно использовать как для представления результатов, так 
и экспорта данных на альтернативные сетки.
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Команда DGENERATE используется для генерации или ко­
пирования пост-данных. Команда позволяет создавать новые 
массивы результатов из существующего массива результатов, 
вычисленных в ячейках или узлах. Это полезно для представле­
ния результатов расчета симметричной модели, где симметрич­
ность или периодичность характера течения используется для 
уменьшения объема и размерности сеточной модели. Сначала 
создаются ячейки и узлы, на которые затем будут копироваться 
результаты. Для образования новых массивов результатов ис­
пользуется команда DGENERATE. Обратите внимание, что сдви­
ги по номерам, которые задаются в команде DGENERATE, долж­
ны быть точно такие же, какие использовались при генерирова­
нии ячеек и узлов.

Отображение (Mapping) массивов результатов можно вы­
полнять на произвольные поверхности или объемы. Команда 
PROSTAR для выполнения этой операции (РМАР) позволяет 
отображать (накладывать поверх) текущие сохраненные резуль­
таты на поверхность, состоящую из shell-ячеек, на объем, со­
стоящий из ячеек или поперечное сечение, определенное коман­
дой PSCREATE. Для выполнения этой операции необходимо 
выполнить следующие шаги:

Шаг 1
Создать shell-ячейки, объемные ячейки или сечения, на ко­

торые будут отображаться (накладываться) результаты, и при­
своить им уникальный индекс ячейки. Подходящий способ для 
создания shell-ячеек -  воспользоваться командой LIVE.

Шаг 2
Выбрать (используя операцию С SET) множество ячеек, из 

которых будут извлекаться данные для отображения. Они долж­
ны охватывать объемные ячейки или shell-ячейки, предназна­
ченные для отображения.
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Шаг 3
Считать результаты, требуемые для выполнения отображе­

ния, используя опции на диалоговой панели Load Cell Post Data.

Шаг 4
Введите команду РМАР для отображения (наложения) со­

храненных результатов для существующей модели на твердо­
тельные объемные ячейки или плоские shell-ячейки. Например, 
чтобы отобразить значения давления из множества ячеек, задан­
ного командой CSET, на ячейки, имеющие тип 5, надо ввести

GETC, Р
РМАР, 5 ,  CSET
Также важно быть уверенным в том, что сетка, на которую 

отображаются данные: а) занимает такое же физическое про­
странство, что и сетка, из которой извлекаются данные, б) не 
имеет совместных узлов с сеткой, из которой извлекаются дан­
ные (если отображаются узловые данные).

9.9. Представление результатов в виде графиков

PROSTAR содержит широкий набор средств для представ­
ления результатов расчета в виде графиков. При построении 
графиков необходимо руководствоваться следующими основ­
ными правилами:

• Любой переменный параметр потока или другая физиче­
ская величина, имеющиеся в PROSTAR или полученные из 
внешних программ, могут быть представлены в виде функции 
любой другой величины.

• Прежде чем нарисовать график, ряд значений этой вели­
чины должны быть загружены в специальное место хранения, 
так называемый регистр для запоминания информации о графи­
ке -  graph register.
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• Построение графика осуществляется отображением на 
экране содержимого любого регистра как функции содержимого 
другого регистра в соответствии с инструкциями пользователя.

• Можно создать один уникальный графический объект, 
так называемый frame, объединяя вместе один или несколько 
графиков. Определение фрейма включает в себя и определения 
других важных элементов графика, таких, как оси, легенды и 
обозначения.

• Изображение графика может состоять из одного или бо­
лее фреймов. В последнем случае необходимо описать, как бу­
дут располагаться фреймы в пределах комбинированного изо­
бражения.

Следовательно, для настройки начальных установок и по­
лучения графического изображения графиков на экране необхо­
димо выполнить следующие шаги:

а) выбрать и загрузить необходимые вам данные,
б) указать тип и свойства графика(ов), в виде которого (ых) 

эти данные будут представляться,
в) отобразить данные на экран.

Следующие несколько разделов будут посвящены описа­
нию этих шагов. Средства графического интерфейса STAR, не­
обходимые для выполнения этих действий, находятся на раз­
личных панелях, расположенных в под-папке Graphs. Некото­
рые их них дублируются опциями в меню Graph, находящегося 
внутри главного окна PROSTAR. Доступ к инструментам для 
построения графиков Graph Tool осуществляется выбором мар­
шрута с панели меню Tools>Graph Tool, куда также включены 
инструменты для выполнения некоторых наиболее общеприня­
тых операций.

Загрузка данных

На этом этапе пользователь указывает данные, которые не­
обходимо загрузить в регистры для запоминания информации о
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графиках -  graph registers. Наиболее общепринятые операции 
выполняются на семи панелях STAR GUIde, сгруппированных в 
под-папке Extract/Graph Data. Они имеют дело со следующими 
типами данных:

• “Field Data”
• “External data”
• “Residual History data”
• “Engineering Data”
• “Analysis History Data”
• “Particle Data”
• “User Data”
В большинстве случаев, загружая данные, вы имеете воз­

можность заодно и проверить эти данные, построив график по 
умолчанию.

Выбор графических данных

После того, как подходящие данные загружены в graph reg­
isters, пользователь может изобразить их на экране в виде гра­
фика, используя установки PROSTAR, принятые по умолчанию. 
В большинстве случаев, однако, перед тем, как вывести график 
в надлежащем виде на экран, пользователю необходимо заказать 
ряд установок. Это осуществляется на панели STAR GUIde 
“Customize Graphs”.

Панель разделена на ряд позиций; каждая из них предлага­
ет различные функциональные настройки, которые пользователь 
может использовать или нет в зависимости от вида и сложности 
графика. Подробное описание назначения и режима выполнения 
операций для каждой позиции дается в интерактивной тексто­
вой системе помощи Help на этой панели. Также существуют 
другие расширенные возможности обработки графика, такие как 
определение пользователем стрелок указателей и введение до­
полнительных специальных обозначений см. гл. 5 Руководства 
пользователя.
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Отображение данных

Для реального отображения графика результатов на экране 
можно воспользоваться специальными текущими установками:

В рамках среды STAR GUIde (любая панель в подпапке 
Graphs) выбором маршрутов:

• Draw Frame>Current -  нарисовать фрейм, выбранный на 
текущий момент.

• Draw Frame>Overlay -  нарисовать фрейм поверх любого 
другого изображения, отображенного на текущий момент в гра­
фическом окне PROSTAR.

• Draw All Frames -  нарисовать все фреймы, определен­
ные на данный момент.

В меню Graphs выбором опций:
• Locate -  изменить размеры и/или расположение фрейма в 

графическом окне.
• Gdraw -  получить изображение фрейма.
• Gredraw -  перерисовать последний отображенный на эк­

ране фрейм со всеми внесенными пользователем изменениями 
параметров изображения.

• Gpick -  отобразить на экране значение в точке графика, 
указанной на выбранном фрейме, с помощью графического кур­
сора. Альтернативно можно использовать команду GPICK. Об­
ратите внимание, что эта операция незаконна для круговых диа­
грамм.

• Gpan -  перенести (панорамировать) центр графика в поло­
жение, указанное курсором. Альтернативно можно использовать 
команду GPAN. Обратите внимание, что эта операция незаконна 
для круговых диаграмм и графиков в полярных координатах.

• Gzoom, on -  зуммировать (т. е. увеличить масштаб) от­
дельную часть графика, выбранную с помощью графического 
курсора; при желании возможно многократное действие. Каж­
дая установка ZOOM должна быть подтверждена нажатием на
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кнопку Yes до выполнения перерисовки фрейма. Опции Gzoom, 
back/Gzoom, off отображают фрейм, используя предыдущие или 
первоначальные параметры масштаба изображения.

Во всех вышеперечисленных случаях нужный фрейм выби­
рается из выпадающего списка. Обычно PROSTAR оперирует 
20 регистрами для хранения графиков, принятыми по умолча­
нию. Изменить количество регистров можно, нажав на кнопку 
Change Number of Registers на любой панели подпапки STAR 
GUIde Graphs и затем указав требуемое вам число регистров в 
специальном всплывающем при этом окне.

Обратите внимание, что если информация о графиках уже 
загружена в некоторые регистры, то сначала необходимо сте­
реть информацию в этих регистрах и переустановить все графи­
ческие параметры на значения, принятые по умолчанию. Это 
можно сделать нажатием на Graph Reset на панели STAR 
GUIde или выбрать маршрут Graph>Greset на панели меню.
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10. ИССЛЕДОВАНИЕ ТЕЧЕНИЯ ЖИДКОСТИ 
В КВАДРАТНОЙ ПОЛОСТИ С ПОДВИЖНОЙ СТЕНКОЙ

10.1. Введение

Течение жидкости в квадратной полости с подвижной стен­
кой относится к задачам, в которых присутствует явление отры­
ва потока от обтекаемого тела. Задачи подобного рода и другого 
типа привели к формированию научного направления, известно­
го как вычислительная гидродинамика, основанная на матема­
тическом моделировании течений жидкости с помощью числен­
ных методов на ЭВМ. Данная задача отображает особенности 
отрывных течений и поэтому используется как «испытательный 
полигон» для изучения возможностей численных методов.

Одним из программных продуктов, реализующих числен­
ные методы, является STAR-CD. В данной лабораторной работе 
моделируется течение жидкости в квадратной полости с под­
вижной стенкой в пакете STAR-CD. Полученные результаты 
сравниваются с результатами из литературного источника.

Цель лабораторной работы -  исследование течения жид­
кости в квадратной полости с подвижной стенкой в двухмерной 
постановке.

Работой предусматривается:
1. Определение поля скоростей, линий тока и давлений в 

расчетной области.
2. Определение профилей продольных и поперечных ско­

ростей в вертикальном и горизонтальном сечениях.
3. Расчёт безразмерного комплекса:

2 F
р £/2/ ’

где F  -  сила трения, которую испытывает движущая стенка, от­
несенная к единице длины в направлении Y.
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Исследуемая квадратная полость с движущейся верхней 
стенкой представлена на рис. 10.1. Течение жидкости считается 
стационарным, вязким и несжимаемым; теплофизические свой­
ства жидкости постоянны и удовлетворяют соотношению:

Решение данной задачи производилось с помощью диффе­
ренциальных уравнений Навье -  Стокса с использованием ЭВМ. 
Одним из таких решений является решение, находящееся в [1].

Математической моделью является система уравнений (вы­
раженная в векторном виде) [1]:

F U

Рис. 10.1. Квадратная полость с движущейся верхней стенкой

При решении задачи использовать следующие данные: 
1 = \ м ; U = 5 m /c; р = 1  кг/м 3; ц = 0,05 77а-с.

10.2. Теоретические основы исследования
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~ ~  = J  -  — grad  ( p) + v A W  + i grad (div (lV Jj.

где W -  полный вектор скорости частицы;

J  -  полный вектор ускорения частицы; 
v -  кинематический коэффициент вязкости;
А -  оператор Лапласа.

Поскольку в начальных условиях было принято, что жид­
кость несжимаема, то последний член, выражающий скорость 
относительной объемной деформации, будет равен нулю

c/iv(w) = 0 . Учитывая отсутствие объемных сил J  = 0 , можно 

переписать данное векторное уравнение в проекции на коорди­
натные оси х и у  (так как было принято, что задача решается в 
двухмерной постановке):

du du du 1 dp 
p dx

f  ,2 d и

dv

dx

dv
dx

v-
, 2d и

dv

P

v dx “
f  j 2 .V

dx“

В начальных условиях было принято, что течение жидкости 
считается стационарным, в этом случае нулю будут равны част­
ные производные составляющих полной скорости по времени:

А  = 0 *  о

В соответствии с принятыми допущениями исходные урав­
нения будут иметь вид:

du du 1
р dxdx

dv
dx

u-
d 2u ^

dv
v-

P

v dx' 
f  j2.О
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Граничными условиями будет задание равенства нулю со­
ставляющих полной скорости на стенках квадратной полости:

х = 0 : и = 0, v = 0; 
х = L : и = 0, v = 0; 
у  = 0 : и = 0, v = 0; 
y  = L : и = U, v = 0.

10.3. Практическая часть

10.3.1. Подготовка к созданию модели

Создаем директорию с номером вашей группы на диске D. 
В данной директории снова создаем директорию с названием 
Lab2.

Запускаем STAR-CD Launcher по ярлыку, расположенному 
на рабочем столе. Выбираем пункт меню File> SetWorkingDi- 
rectory и выбираем созданную директорию Lab2.

Запустим модуль STAR, для этого выбираем пункт меню 
File>Pre/Post>Prostar. В появившемся окне нажимаем Continue. 
Запускается пакет и появляются главное и командное окна.

10.3.2. Создание сетки

С
STAR

GUIdeЗапустите окно помощника, нажав на кнопку:
• В появившемся окне помощника выбираем папку Create 

and Import Grids;
• Выберете папку Create Grids;
• Нажмите на значок строки Create 3-D Grids using Simple 

Shapes.
Обычно в данный момент нужно определить тип создавае­

мых ячеек и вид текущей координатной системы, для этой зада­
чи эти установки принимаются заданными по умолчанию, что 
соответствует глобальной декартовой системе координат и типу 
ячеек -  Fluid. Для создания сетки необходимо заполнить соот­

89



ветствующие позиций диалога Extend o f Domain так, как показа­
но ниже:

Extent o f D om ain : 

M in im um  M aximum N um ber o f C ells

0 Z1

X X X

0 1 21
Y Y V

0 I" 0.05 1
Z z z

Рис. 10.2. Задание координат расчетной области

• Нажмите на кнопку Generate Mesh. В окне PROSTAR 
появится блок с размерами по осям X  и Y от 0 до 1 и от 0 до 0,05 
по оси Z, где число ячеек по осям X, Y, Z  соответственно равно 
21, 21 и 1. Координаты вершин и описание ячеек можно про­
смотреть помощью верхнего меню PROSTAR Lists>Vertices 
(координаты вершин, необходимо установить флажок Show All- 
Verts) и Lists>Cells (описание ячеек). Для более удобного про­
смотра расчетной области изменим точку зрения.

• Нажмите на кнопку View в верхнем управляющем интер­
фейсе окна PROSTAR и выберите View>lsometric>l, 1,1.

При этом должен быть установлен режим просмотра- 
Geometry Plot, тип просмотра -  Hidden Surface, тогда изобра­
жение расчетной области в окне PROSTAR будет соответство­
вать рис.10.3.

10.3.3. Задание границ

Следующим шагом будет задание границ расчетной облас­
ти. В нашей модели граничные поверхности, нормальные осям 
X  и Y, являются стенками, причем верхняя стенка (Г+) движется, 
а поверхности, нормальные оси Z, являются плоскостями сим-
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метрии. По умолчанию предполагается, что все граничные по­
верхности имеют тип Стенка (Wall).

В этом случае нужно определить только плоскости симмет­
рии и движущуюся стенку, а остальные оставить определенны­
ми по умолчанию. Для этого:

• Выберите в окне Navigation Center (NavCentr) папку 
Locate Boundaries, откройте ее и щелкните на значке, стоящем 
перед названием строки Create Boundaries. В правой части окна 
появится меню определения границ.

• Выделите курсором строчку номер один в окне Boundary> 
Regions и, нажав на кнопку Symmetry, задайте тип границы для 
плоскости симметрии.

• Нажмите на кнопку View в верхнем управляющем интер­
фейсе окна PROSTAR и выберите View>Axis>+Z.

• Нажмите на кнопку Surface Based on Edge и, указав 
мышкой на видимую плоскость симметрии расчетной области,
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Рис. 10. 3. Полученная сетка
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показанной в окне PROSTAR, щелкните левой кнопкой мыши.
• Нажмите на кнопку View в верхнем управляющем интер­

фейсе окна PROSTAR и выберите View>Axis>-Z.
• Нажмите на кнопке Surface Based on Edge и выделите 

мышкой в окне PROSTAR оставшуюся плоскость симметрии, 
которая теперь стала видимой.

• В текстовом окне Boundary Region Name наберите назва­
ние SymPlane и нажмите кнопку Apply.

• Выделите курсором строчку номер два в окне Boundary 
Regions и, нажав на кнопку Wall, задайте тип границы для дви­
жущейся верхней стенки.

• Нажмите на кнопку View в верхнем управляющем интер­
фейсе окна PROSTAR и выберите View>Axis>+Y.

• Нажмите на кнопке Select a Zone и нарисуйте произволь­
ный многоугольник вокруг верхней поверхности.

• В текстовом окне Boundary Region Name наберите назва­
ние MuvWall и нажмите кнопку Apply.

• Нажмите на кнопку View в верхнем управляющем интер­
фейсе окна PROSTAR и выберите View>lsometric>l, 1, 1. На­
жмите кнопку Bound (Отображение границ) в меню Cell Plot 
Display Options.

• Нажмите на кнопку Count All Boundaries и в текстовом 
выводе данных в окне OUTPUT будет выведена обобщающая 
информация по граничным областям, а в окне PROSTAR будут 
показаны выделенные граничные поверхности (см. рис. 10.4).

10.3.4. Задание свойств среды

Задание физических свойств производится следующим об­
разом:

• Выберите в окне Navigation Center (NavCentr) папку 
Thermophysical Models and Properties, откройте папку Liquids 
and Gases и, выбрав строчку Molecular Properties, щелкните на
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значке, стоящем перед ее названием. В правой части окна поя­
вится меню определения физических свойств жидкости.

• В текстовом окне Molecular Properties for введите Fluid.
• В текстовом окне Density введите 1.
• В текстовом окне Molecular Viscosity введите 0?05.
• Нажмите кнопку Apply.
Выберем ячейку для вывода промежуточных данных в тек­

стовый файл при решении задачи -  Monitoring Cell и ячейку -  
Reference Pressure Cell, относительно которой будет опреде­
ляться перепад давления. Выберем ячейки, расположенные со­
ответственно в центре расчетной области и в левом нижнем уг­
лу. Для этого:

• Отжать кнопку Bound в блоке Cell Plot Display Option 
верхнего управляющего интерфейса окна PROSTAR (Выключе­
ние ре.жим а показа граничных областей).

• Нажмите на кнопку View в верхнем управляющем интер­
фейсе окна PROSTAR и выберите View>Axis>+Z.
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Рис. 10.4. Граничные поверхности модели
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• В окне Navigation Center (NavCentr) откройте последова­
тельно папки Thermophysical Models and Properties/Liquids and 
Gases, выберите строчку Monitoring and Re ference Data for Fluid 
и щелкните на значке, стоящем перед ее названием.

• В правой половине окна Navigation Center (NavCentr) в

блоке Monitoring Information щелкните по кнопке -S J  и выде­
лите появившимся перекрестьем в окне PROSTAR центральную 
ячейку (ее номер 221).

• В блоке Reference Data в строке Reference Pressure Cell

Number щелкните по кнопке JSlI и  выделите появившимся 
перекрестьем в окне PROSTAR левую нижнюю ячейку (ее но­
мер 1).

• Нажмите кнопку Apply.

10.3.5. Задание граничных условий

Для задания граничных условий необходимо задать только 
значение скорости, с которой движется верхняя стенка полости. 
Все остальные граничные условия задаются по умолчанию с 
помощью типов заданных границ. Так, для типа Wall заданы ус­
ловия прилипания, а тип Symmplane обеспечивает условия плос­
кости симметрии. Для задания скорости на верхней стенке:

• Выберите в окне Navigation Center (NavCentr) папку 
Define Boundary> Conditions и, выбрав строчку Define Boundary> 
Regions, щелкните на значке, стоящем перед ее названием. В 
правой части окна появится меню задания граничных условий 
по границам.

• Выделите курсором границу под номером два в окне 
Boundary Regions и в текстовом окне U введите 5.

• Нажмите кнопку Apply.
• Нажмите на кнопку View в верхнем управляющем интер­

фейсе окна PROSTAR и выберите View>lsometric>l,l,l.
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• Нажмите кнопку Bound в блоке Cell Plot Display Option 
верхнего управляющего интерфейса окна PROSTAR.

• Нажмите кнопку Cell Plot и в окне PROSTAR будет пока­
зана расчетная область с поставленными граничными условия­
ми, приведенная на рис. 10.5.

На данном этапе модель готова для решения поставленной 
задачи, поэтому её следует сохранить. Это можно сделать, вы­
брав в окне PROSTAR в выпадающем меню File:

File>Save Model

Данная задача является двумерной, но решается в трехмер­
ной постановке. Для увеличения скорости сходимости числен­
ного решения задачи нужно отключить решение уравнения 
движения для 1Т-компонснты вектора скорости. Для этого:
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Рис. 10.5. Результат задания граничных условий модели

10.4. Подготовка к решению модели

10.4.1. Управление решением задачи
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• Выберите в окне Navigation Center (NavCentr) папку 
Analysis Controls и последовательно откройте папки Solution 
Controls и Equation Behavior, в строке Primary Variables щелкни­
те на значке, стоящем перед ее названием. В закладке Primary 
Variables, появившейся в правой части окна, отожмите кнопку 
рядом со строкой W-mom.

• Нажмите кнопку Apply.

10.4.2. Управление выводом

По умолчанию вывод результатов расчета в файл происхо­
дит с кратностью 100. Для изменения частоты вывода:

• Выберите в окне Navigation Center (NavCentr) папку 
Output Controls, откройте ее и в строке Analysis Output, щелкни­
те на значке, стоящем перед ее названием. В закладке Post, в 
текстовом окне Solution Output Frequency наберите 30.

• Нажмите кнопку Apply.

Для расчета безразмерного комплекса требуется значение 
силы трения, которую испытывает движущая стенка. Получение 
значения возможно из файла star.erd, который будет создан в 
процессе решения модели. Укажем необходимость сохранения 
значения силы по итерациям в процессе решения в вышеназван­
ном файле:

• Выберите в окне Navigation Center (NavCentr) в папке 
Output Controls папку Monitor Engineering Behavior, щелкните на 
значке, стоящем перед названием строки Monitor Boundary 
Behavior. В правой части окна выберите курсором границу 
"2-Wall" и для нее нажмите кнопку Forces.

• Нажмите кнопку Apply.

10.5. Проверка модели

Теперь, когда модель задачи собрана, требуется провести 
проверку созданной модели.
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Откройте в окне Navigation Center (NavCentr) папку Check 
Model Setup и щелкните на значке, стоящем перед строкой Check 
Everything. В панели Check Everything, появившейся в правой 
части, нажмите кнопку АН под строкой Check Everything.

Результаты проверки модели будут в текстовом виде пред­
ставлены в окне OUTPUT на рис. 10.6.

Prostar Output: star

J  Short Input History

Рис. 10.6. Результаты проверки модели, представленные в окне OUTPUT

10.6. Финальные действия

Откорректируем максимальное число итераций при чис­
ленном решении задачи:

• Откройте в окне Navigation Center (NavCentr) папку 
Analysis Preparation/Running и щелкните на значке, стоящем пе­
ред строкой Set Run Time Controls. В панели Set Run Time
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Controls, появившейся в правой части в текстовом окне Number 
o f Iteration, наберите 500.

• Нажмите кнопку Apply.
Перед завершением работы с модулем PROSTAR сохраним 

модель в файле star.mdl и создадим файлы с описанием геомет­
рии расчетной области и описанием условий однозначности за­
дачи, необходимые для модуля STAR. Для этого в окне 
PROSTAR откроем выпадающее меню File:

• File>Save Model.
• File>Write Geometry File>Apply>Close.
• File>Write Problem File>Apply>Close.

В результате вышеописанных действий были созданы фай­
лы, необходимые для запуска модуля STAR, -  star.geom и 
star.prob. Для большей наглядности численного решения данной 
задачи применение модуля STAR будем проводить отдельно и 
независимо от PROSTAR. Для чего завершим работу с модулем 
PROSTAR: File>Quit>Save&Quit.

Проведение численного решения в модуле STAR

• Запустим модуль STAR в панели Star-CD Launcher: 
Solve>Star. В результате откроется окно Star -  Solver Settings.

• Во вкладке Executable Settings в поле ввода Casename 
указывается имя решаемого файла {star.mdl).

• Переходим на вкладку Run Solver, нажимаем на кнопку 
Start, находящуюся в прямоугольной области с названием Serial 
Star. На экран выводится уведомляющее окно Starlauncher, ко­
торое говорит о том, что будет запущен модуль решения Star в 
консольном режиме. Нажать кнопку ОК.

• По окончании расчетов консольном окне появится над­
пись «Для продолжения работы нажмите любую клавишу». Со­
ответственно для его закрытия нажмите любую клавишу.
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• Закройте окно Star -  Solver Settings, нажав на кнопку 
Close.

10.7. Обработка результатов расчета в PROSTAR

10.7.1. Подготовка

Запустим модуль STAR. Для этого выбираем пункт меню 
File>Pre/Post>Prostar. На экране появится окно запуска 
PROSTAR, в которое нужно ввести следующее:

• Подтвердить имя задачи star в строке Enter Case Name
• Подтвердить опцию Resume from Existing .mdl File?
• Отменить опцию Append to Previous .echo File?
• Нажать Continue.

10.7.2. Загрузка файла с результатами расчетов

В открывшемся окне PROSTAR в верхнем управляющем 
интерфейсе:

• Отожмите кнопку Bound в блоке Cell Plot Display Option
• Нажмите кнопку Cell Plot.

,  t
Запустите окно помощника, нажав на кнопку:

STAR
GUIde

• В открывшемся приложении выберите в окне Navigation 
Center (NavCentr) папку Post-Processing, откройте её и щелкните 
на значке, стоящем перед строкой Load Data. В правой части 
появится меню загрузки результатов численного решения.

• Проверьте имя файла star.pst в текстовом окне Steady 
State Post File.

• Нажмите на кнопку Open Post File.

10.7.3. Построение поля вектора скорости

Выполните следующие действия для построения поля век­
тора:
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• В открытом меню Load Data окна Navigation Center 
(NavCentr) щелкните на закладке Data.

• Проверьте значения кнопки Data Туре -  Cell.
• Проверьте значения кнопки Smooth Option -  Off.
• В блоке Vector Data должна быть нажата кнопка Velocity.
• В блоке Scalar Data должна быть нажата кнопка None.
• Нажмите на кнопку Get Data.
• Нажмите на кнопку Go to Create Plots.
• В открытой закладке появившегося окна Create Plots ус­

тановите значение кнопки Option -  Vector, а кнопки Edge/Mesh 
-  Edge.

• Нажмите на кнопке Plot to Screen и в окне PROSTAR 
появится векторное поле, приведенное на рис. 10.7.

• Нажмите кнопку Plot to File для запоминания построен­
ных результатов в нейтральном файле star.plot.

• Нажмите кнопку Go to Load Data для возвращения к ок­
ну Load Data.

PR O ST A R  3,10

16 —O c t—06  
VELOCITY MAGr 
M/S
ITER = 73
LO CA L MX= 4.1 E 
LO CA L MN= 0,11

1 6 - O c t - 0 6
V E LO C ITY  M A G N ITU D E 
M /S
ITER = 73
LO CA L MX= 4,151 
LO CA L MN= 0 ,1 1 9 7 E -0 2

4.151 
3.855 
3.558 
3.262 
2.966 
2.669 
2.373 
2.076 
1.780 
1.483 
1.187 

0.8905 
0.5941 
0.2976
0.1197E-02

Y

.X

Рис. 10.7. Поле вектора скорости 
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10.7.4. Построение поля давления

Для построения в окне PROSTAR поля давления:
• В открытом меню Load Data окна Navigation Center 

(NavCentr) откройте закладку Data.
• Установите значения кнопки Data Туре -  Cell &Wall/ 

Bound (Smooth).
• В блоке Vector Data должна быть нажата кнопка None.
• В блоке Scalar Data должна быть нажата кнопка Pressure.
• В блоке Options должно быть установлено значение 

кнопки Pres. R e f -  Relative.
• Нажмите на кнопку Get Data.
• Нажмите на кнопку Go to Create Plots.
• В открытой закладке появившегося окна Create Plots 

установите значение кнопки Option -  Contour (filled), а кнопки 
Edge/Mesh -  Edge.

• Нажмите на кнопке Plot to Screen и в окне PROSTAR 
появится поле давления, приведенное на рис. 10.8.
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Рис. 10.8. Поле давления
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• Нажмите кнопку Plot to File для запоминания построен­
ных результатов в нейтральном файле star.plot.

• Нажмите кнопку Go to Load Data для возвращения к ок­
ну Load Data.

10.7.5. Построение поля линий тока

Для построения в окне PROSTAR поля линий тока:
• В меню Load Data окна Navigation Center (NavCentr) 

должна быть открыта закладка Data.
• Должно быть установлено значение кнопки Data Туре -  

Cell & Wall/Bound (Smooth).
• В блоке Vector Data должна быть нажата кнопка None.
• В блоке Scalar Data должна быть нажата кнопка Stream.
• Нажмите на кнопку Get Data.
• Нажмите на кнопку Go to Create Plots.
• В открытой закладке появившегося окна Create Plots 

установите значение кнопки Option -  Contour (line), а кнопки 
Edge/Mesh -  Edge.

• Нажмите на кнопке Plot to Screen и в окне PROSTAR 
появится поле линий тока.

• Нажмите на кнопку View в верхнем управляющем интер­
фейсе окна PROSTAR и выберите View>Axis>+Z. Получившее­
ся поле линий тока приведено на рис. 10.9.

• Нажмите кнопку Plot to File для запоминания построен­
ных результатов в нейтральном файле star.plot.

• Нажмите кнопку Go to Load Data для возвращения к ок­
ну LoadData.

10.7.6. Построение профиля скорости U

Для построения профиля скорости в центральном верти­
кальном сечении полости воспользуемся выделением набора 
ячеек, через которые это сечение проходит:
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Рис. 10.9. Поле линий тока

• Измените значение в верхнем управляющем интерфейсе 
окна PROSTAR кнопки Contour Plots на Geometry Plot.

• Отожмите кнопку ®  в боковом управляющем интерфей­
се окна PROSTAR.

• В меню Plot окна PROSTAR установите вывод на экран, 
вместо установленного вывода в файл -  Plot>Plot to Screen.

• Нажмите кнопку Cell Plot верхнего управляющего ин­
терфейса окна PROSTAR.

• Нажмите кнопку I  в боковом управляющем интерфейсе 
окна PROSTAR и в открывшемся меню -  New>Zone...

• В окне PROSTAR постройте при помощи мыши много­
угольник, охватывающий центральный вертикальный ряд ячеек.

• Нажмите кнопку Cell Plot верхнего управляющего ин­
терфейса окна PROSTAR. В окне PROSTAR будет изображен 
только выделенный ряд ячеек, как показано на рис. 10.10.

Таким образом, была выделена подобласть, Y -  координаты 
которой будут использоваться для построения графика. Сейчас
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необходимо ввести значения ^-компоненты скорости для вы­
бранного набора ячеек. Для этого:

• В открытом меню Load Data окна Navigation Center 
(NavCentr) щелкните на закладке Data.

• Установите значение кнопки Data Туре -  Cell.
• Установите значение кнопки Smooth Option -  Off.
• В блоке Vector Data должна быть нажата кнопка None.
• В блоке Scalar Data должна быть нажата кнопка Velocity 

U-comp.
• Нажмите на кнопку Get Data.
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Рис. 10.10. Выделенный ряд ячеек

Введем отобранные результаты в графические регистры, 
которые затем используем для вывода графической информа­
ции:

• В меню Graph окна PROSTAR выберите строку Load 
Graph Data - Graph>Load Graph Data...

• В открывшемся окне Load Graph Registers нужно выбрать 
строку Load cell/vertex/sensor/wall numbers and data как показано 
ниже:
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Load G raph  R egisters

C h a n g e  th e  n u m b e r  o f  g ra p h  r e g i s t e r s . . .
Fill graph r e g is te r s  w ith  u s e r - s p e c i f ie d  v a lu e s . . .  
Fill g rap h  r e g i s te r s  w ith  d a ta  from  e x te rn a l file—
L oad  c e l l / v e r t e x / s e n s o r / w a l l  n u m b e r s  a n d  d a t a . . .
L oad  S T A R  r e s id u a l s  a n d  m o n i to r e d  v a l u e s . . .
L oad  t r a n s i e n t  p o s t  d a t a . . .
L oad  p a r t i c le /d r o p le t  t r a c k  d a t a . . .
D e fin e  s e n s o r s  a n d  lo ad  g e o m e t r y  a n d  p o s t  d a t a . . .

A pp ly  C lo se

• Нажмите кнопку Apply.
• В появившемся окне Load Geometry and Post Data введите 

данные так, как показано ниже:

Ф] Load Geometry and  Post Data

Load C e llA '/a ll/V e rte x /S e n so r N u m b e rs  a n d  D a ta

R e g is te r  f o r  c e l / v e r t e x / s e n s o r  n u m b e r s

Cell T y p e  o f  d a t a

S e t From To

S ta r t in g  lo c a tio n  in  r e g is t e r

R e g is te r  f o r  g e o m /p o s t  d a t a

D a ta  t o  lo ad

IC S o r  sp lin e  N u m b e r

Load N u m b e rs

Load D a ta C lose

Load N u m b e rs  
a n d  D a ta

• Нажмите на кнопку Load Numbers and Data для ввода 
в графический регистр номеров, а во второй регистр значений 
координат по оси Y для центров отобранных ячеек.
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• Измените значения номера графического регистра, куда 
вводятся данные, и значение кнопки Data to load так, как пока­
зано ниже:

Load C e lA '/a J I /V e r te x /S e n s o r  N u m b e rs  a n d  D a ta

1 R e g is te r  f o r  c e l l / v e r t e x / s e n s o r  n u m b e r s

Cell _ i  t y p e  o l  d a t a

S e t  - i  | F ro m  T o  Г  B y  f

1 S ta r t in g  lo c a tio n  in  r e g i s t e r

3  R e g is te r  f o r  g e o m /p o s t  d a t a

P o s t  4  —I D a ta  to  load

IC S  o r  s p l in e  N u m b e r

L oad N u m b e rs

Load D a ta

L oad N u m b e rs  
a n d  D a ta

• Нажмите на кнопку Load Data.
• Нажмите на кнопку Close.
• В меню Graph окна PROSTAR выберите строку Graph 

Registers... -  Graph> Graph Registers...
В открывшемся окне Graph Registers будут заполнены пер­

вые 5 регистров:
1. Номера выбранных ячеек (CELL NUMBER).
2. 7-координаты центров ячеек (Numerical).
3. Значения ^-компоненты вектора скорости (SU).
Для проведения сравнения результатов решения пакета 

STAR-CD с известным решением, приведенным в источнике [2], 
введем значения скоростей в поперечном сечении взятых из это­
го источника и приведенных в табл. 10.1.
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Таблица 10.1. Значения скоростей в поперечном сечении по [2]

Значение 
Y координаты

Значение 
приведенной скорости U

0,127 -0,079
0,273 -0,152
0,385 -0,203
0,47 -0,209

0,579 -0,167
0,668 -0,089
0,749 0,018
0,884 0,332
0,94 0,574

0,974 0,789

Значения первого столбца необходимо ввести в 4-й регистр, 
следующим образом:

• Выделите четвертую строчку в списке Registers.
• Напишите название Y calculate для регистра в поле Label 

for Register 4 (CR to enter), по окончании ввода нажмите клави­
шу Enter на клавиатуре.

Н ф к п
1 С1X1 ММ IX

Rogntor 1 D tvilw  2 Itrqialer 3 Regulor 4 ПсфаЫг 0 h g i l t r  G 
C tll HUMHIK Huntmtr.il SO Vco4r.ul.Tto U colcutoto (HraKitorK)

]  я | * _ su 0 02Я016 -0.0176301 0 .127 -41.079
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6 (XrijiTtrr в)
7 Iteq iiltr  7)

Э 213 0.119010 0.0609494 0.306 -0.20Э
4 214 0.166667 0.0096691 0.47 0.209

9 I k fH U r  9) e 21b
216

0.214206 
0 26190S

-0.100664 
-0.12642.1

0.679 -41.167
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Я
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Рис. 10.11. Окно Graph Registers
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• Введите все значения из первого столбца табл. 10.1 в 
столбец регистра 4, подтверждая нажатием на клавишу Enter на 
клавиатуре.

Введите таким же образом значения в 5-й регистр из второ­
го столбца табл. 10.1, изменив название регистра на U calculate.

Для проведения сравнения необходимо перевести значения 
(/-компоненты в третьем регистре в безразмерную форму, раз­
делив на величину скорости, с которой движется верхняя стенка 
(в нашем случае 5 м/с).

Для модификации значений продольной скорости восполь­
зуемся кнопкой Register Operation... окна Graph Registers.

• Нажмите на кнопку Register Operation...
• В открывшемся окне Graph Register Operation... измените 

регистр 3, умножив его на 0,2 (1/5), как показано на рис. 10.12.

G raph  R egister O pera tions -  xj
Graph R eg iste r O perations

3 0.2 1.0* (Rog 3 ) 1.0* (Reg )

Рис. 10.12. Окно Graph Register Operation...

• Нажмите кнопку Apply.
• Нажмите кнопку Close.
• В окне Graph Registers выделите курсором название вто­

рого регистра в окне Registers.
• Измените название регистра, набрав в текстовом окне 

Label for Register 2 Numerical.
• Нажмите клавишу ENTER на клавиатуре.
• В окне Graph Registers выделите курсором название чет­

вертого регистра в окне Registers.
• Установите значение кнопки Style блока Line Parameters 

-  None.
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• Установите значение кнопки Style блока Symbol Parame­

ters -
• Результирующий вид окна Graph Registers, после выпол­

нения вышеприведенных операций, показан на рис. 10.11.
Для определения параметров оформления графического 

вывода:
• В меню Graph окна PROSTAR выберите строку Graph 

Display... - Graph> Graph Display ...
• В открывшемся окне Graph Module введите значения так, 

как показано на рис. 10.13.
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Рис. 10.13. Окно Graph Module

• Выделите 3-ю строчку в списке X-Axis Register, 2-ю 
строчку в списке Y-Axis Register, нажмите кнопку Add Register 
Pair.
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• Выделите 5-ю строчку в списке X-Axis Register, 4-ю 
строчку в списке Y-Axis Register, нажмите кнопку Add Register 
Pair.

• Нажмите на кнопку Apply Changes окна Graph Module.
• Нажмите на кнопку Draw Current Frame окна Graph 

Module.
В окне PROSTAR появится фрейм, показанный на рис. 

10.14, настройки которого определяются установками окна 
Graph Module.

STAR

D
PR O STA R  3,1 D

1 9 - О Й - 0 6

G RA PH  PLO T 
FRA M E 1

Рис. 10.14. Профиль безразмерной скорости в поперечном сечении

На рис. 10.14 линией показаны результаты расчета про­
граммы STAR-CD, а треугольниками отмечены значения в соот­
ветствии с табл. 10.1.

• В меню Plot окна PROSTAR установите вывод в файл, 
вместо установленного вывода на экран- Plot>Plot to File.

• Нажмите на кнопку Draw Current Frame окна Graph 
Module.

• Нажмите на кнопку Close окна Graph Module.
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• Нажмите на кнопку Close окна Graph Registers.
• В меню Plot окна PROSTAR установите вывод на экран -  

Plot>Plot to Screen.

• Нажмите кнопку с-.
в боковом управляющем интерфей­

се окна PROSTAR и в открывшемся меню выберите -  АН.
• Нажмите кнопку Cell Plot верхнего управляющего ин­

терфейса окна PROSTAR, для вывода расчетной области.

10.7.7. Построение профиля скорости V

Для построения профиля поперечной скорости в централь­
ном горизонтальном сечении полости применим построение в 
сечении набора дополнительных узлов, лежащих в плоскости 
сечения и называемых сенсорами.

Ы Н Е /BAR SYMBOL

c s e t , a l l

t e r m , , x

c p l o t

j5] Prostar Output: star

e p l o t

Short input History

Рис. 10.15. Ввод команд для создания крайних узлов набора сенсоров
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В командной строке окна OUTPUT введите команды для 
создания крайних узлов набора сенсоров с координатами (1.0, 0.5,
0.0), (0.0, 0.5, 0.0) и номерами 10001 и 10002 соответственно.

• V 10001 1.0 0.5 0.0
• V 10002 0.0 0.5 0.0
Вид окна с результатом выполнения этих команд представ­

лен на рис. 10.15.
Введем значения полей скорости в расчетной области. Для 

этого:
• В открытом меню Load Data окна Navigation Center 

(NavCentr) щелкните на закладке Data.
• Установите значение кнопки Data Туре -  Cell.
• Установите значение кнопки Smooth Option -  Off.
• В блоке Vector Data должна быть нажата кнопка Velocity.
• В блоке Scalar Data должна быть нажата кнопка None. 

Нажмите на кнопку Get Data.
Создадим набор из 20 сенсоров, лежащих между 10001 и 

10002 узлами. Для этого:
• В меню Graph окна PROSTAR выберите строку Load 

Graph Data... - Graph>Load Graph Data...
• В открывшемся окне Load Graph Registers нужно выбрать 

строку Define sensors and load geometry and post data...

-  X

Define s e n s o r  loca tions b e tw e e n  tw o  v e r tic e s  
and  load g e o m e tr /  and p o s t d a ta

| 10001 V ertex Num ber fo r firs t s e n s o r

рюоог V ertex Num ber fo r la s t  s e n s o r

20 Total num ber o f s e n s o rs  to  define

| 1 Sta rting  re g is te r  num ber

Apply Close

Рис. 10.16. Окно Define Sensor Location
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• Нажмите кнопку Apply.
• В появившемся окне Define Sensor Location введите дан­

ные так, как показано на рис. 10.16.
• Нажмите кнопку Apply.
• Нажмите кнопку Close.
• Нажмите кнопку Close в окне Load Graph Registers.
Для изображения набора сенсоров окне PROSTAR:
• В меню Plot окна PROSTAR выберите строку Vertex 

Style... и установите размер символа для узла равный 4 -  
Plot>Vertex Style. ..>Size>4,

• Нажмите кнопку V >J в боковом управляющем интерфей­
се окна PROSTAR и в открывшемся меню выберите New>AII 
Sensors.

• Нажмите кнопку Vertex в блоке Cell Plot Display Option 
верхнего управляющего интерфейса окна PROSTAR.

• Нажмите кнопку Cell Plot верхнего управляющего ин­
терфейса окна PROSTAR для вывода набора сенсоров, показан­
ных на рис. 10.17.

STAR

D
PR O S T A R  3.10

15-oct-oe
V IE W  0.000 0.000 

1.000 
AN G LE 0.000 
D ISTA N C E 

0 .713  
CEN TER 

0 .5 2 4  
0 .527  
0 .040  

EHIDDEN PL O T

Рис. 10.17. Набор сенсоров
113



Для построения графического изображения профиля попе­
речной скорости:

• В меню Graph окна PROSTAR выберите строку Graph 
Registers... -  Graph> Graph Registers...

В открывшемся окне Graph Registers будут заполнены пер­
вые 8 регистров:

1. Номера выбранных сенсоров.
2. Дистанция между сенсорами.
3. X -координаты сенсоров.
4. Г-координаты сенсоров.
5. Z-координаты сенсоров.
6. Значения ^-компоненты вектора скорости.
7. Значения [ -компоненты вектора скорости.
8. Значения [Г-компоненты вектора скорости.
Так как окно ограниченно по ширине, то будет видно пер­

вые 6 регистров.
• Выведите значение седьмого регистра в четвертый стол­

бец, выделив седьмой регистр в окне Registers и нажав на кноп­
ку Display Reg. под четвертым столбцом.

• Измените название регистра, набрав в текстовом окне La­
bel for Register 7 -  Numerical, подтвердив нажатием клавиши 
Enter на клавиатуре.

• Нажмите на кнопку Register Operation... окна Graph Reg­
isters.

В открывшемся окне Graph Register Operation измените 
седьмой регистр, домножив его на величину, обратную значе­
нию скорости верхней стенки (то есть на 0,2), подобным обра­
зом, как в предыдущем пункте.

• Нажмите кнопку Apply окна Graph Register Operation.
• Выведите незаполненный девятый регистр в пятый стол­

бец, выделив девятый регистр в окне Registers и нажав на кноп­
ку Display Reg. под пятым столбцом.
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• Выведите незаполненный десятый регистр в шестой 
столбец, выделив десятый регистр в окне Registers и нажав на 
кнопку Display Reg. под шестым столбцом.

Введем значения скоростей в продольном сечении, взятых 
из источника [2], приведенных в таблице 10.2.

Таблица 10.2. Значения скоростей в продольном сечении по [2]

Значение
Х-координаты

Значение 
приведенной скорости V

0,089 0,112
0,191 0,163
0,287 0,17
0,461 0,086
0,579 -0,018
0,633 -0,081
0,748 -0,226
0,848 -0,226
0,899 -0,162
0,95 -0,084

Значения первого столбца необходимо ввести в девятый ре­
гистр следующим образом:

• Выделите девятую строчку в списке Registers.
• Напишите название X  calculate для регистра в поле Label 

fo r Register 4 (CR to enter), нажмите клавишу Enter на клавиа­
туре.

• Введите все значения из первого столбца табл. 10.2 в пя­
тый столбец, подтверждая нажатием на клавишу Enter на кла­
виатуре.

Введите таким же образом значения в десятый регистр из 
второго столбца табл. 10.2, изменив название регистра на V cal­
culate.

Для корректировки параметров графического отображения 
введенных данных проведем следующие действия:
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• В окне Graph Register выделите название десятого реги­
стра.

• Установите значение кнопки Style блока Line Parameters 
-  None.

• Установите значение кнопки Style блока Symbol Parame­

ters -
• Установите значение кнопки Color блока Symbol Parame­

ters -  4.
• Нажмите на кнопку Close окна Graph Register Operation. 
Результирующий вид окна Graph Registers приведен на рис.

10 . 18 .
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Рис. 10.18. Окно Graph Registers

Для определения параметров графического вывода:
• В меню Graph окна PROSTAR выберите строку Graph 

Display... -  Graph>Graph Display...
• Очистите установленные значения от предыдущего по­

строения в окне Register Pairs нажатием на кнопку Clear.
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• В открывшемся окне Graph Module введите значения так, 
как показано на рис. 10.19.
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Рис. 10.19. Окно Graph Module

• Нажмите на кнопку Apply Changes окна Graph Module.
• Нажмите на кнопку Draw Current Frame окна Graph 

Module.
В окне PROSTAR появится фрейм, показанный на рис. 

10 .20 .

Для вывода фрейма в файл:
• В меню Plot окна PROSTAR установите вывод в файл -  

Plot>Plot to File.
• Нажмите на кнопку Close окна Graph Module.
• Нажмите на кнопку Close окна Graph Registers.
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STAR

D
PR O S T A R  3.10

19 - O c t - 0 6

G R A PH  P L O T  
F R A M E  1

Рис. 10.20. Профиль безразмерной скорости в продольном сечении

10.7.8. Расчет комплекса f

Для определения комплекса:
_ 2F  _ ISxforce 

' pU 2l pU 2lAZ 

используем значение силы трения -  Sxforce на верхней движу­
щейся стенке, значение которой по итерациям выводилось при 
численном решении в файл star, erd (вывод которой был настро­
ен в п. 3.2.).

В командной строке окна OUTPUT введите команду для 
построения графика изменения силы трения по итерациям:

• Edgraph star.erd Sxforce 2.
Результат действия команды представлен на рис. 10.21.
В окне PROSTAR появится фрейм, который нужно изме­

нить следующим образом:
В меню Graph окна PROSTAR выберите строку Graph Reg­

isters... -  Graph> Graph Registers...

yJL
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GRAPH НО. X REG Y  REG LIME/BAR SYMBOL

E d g r a p h  s t a r . e r d  S x f o r c e  2

GRAPH МО. X REG Y  REG L IЫЕ/BA R  SYMBOL

P ro sta r O utput: s ta r

g d r a w ,1
E d g r a p h  s t a r . e r d  S x f o r c e  2

J  Short Input History

Рис. 10.21. Результат действия команды Edgraph star.erd Sxforce 2

В открывшемся окне Graph Registers нужно перевести зна­
чение силы трения в третьем регистре в безразмерную форму. 
Для этого воспользуемся кнопкой Register Operation... 
окна Graph Registers.

• Нажмите на кнопку Register Operation... окна Graph Reg­
isters.

В открывшемся окне Graph Register измените второй ре­
гистр, домножив его на величину следующего коэффициента:

2 2 
 ; =  ; =  1, 6 .
pU 1AZ 1-5 -0,05 

На рис. 10.22 представлено окно Graph Registers Operations.

• Нажмите на кнопку Apply окна Graph Register Operation.
• Нажмите на кнопку Close окна Graph Register Operation.
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j5J G ra p h  R eg iste r O perations

Graph Register Operations

Reg Z = [Тб 1.0* - i  | (Reg [ г  ) * - i  |fo " 1.0* —i | (Reg )

Apply Copy Data... | Sort Data... | Close

Рис. 10.22. Окно Graph Registers Operations

• Нажмите на кнопку Close окна Graph Register.
• В меню Graph окна PROSTAR выберите строку Graph 

Display... - Graph> Graph Display...
• В открывшемся окне Graph Module введите значения так, 

как показано ниже (рис. 10.23).

Рис. 10.23. Окно Graph Module

• Нажмите на кнопку Apply Changes окна Graph Module.
• Нажмите на кнопку Draw Current Frame окна Graph 

Module.
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В результате в окне PROSTAR появится фрейм, показан­
ный на рис. 10.24.

Для вывода фрейма, изображенного в окне PROSTAR, в 
файл:

• В меню Plot окна PROSTAR установите вывод в файл -  
Plot>Plot to File.

• Нажмите на кнопку Draw Current Frame окна Graph 
Module.

• Нажмите на кнопку Close окна Graph Module.
• Нажмите на кнопку Close окна Graph Registers.В меню 

Plot окна PROSTAR установите вывод на экран Plot>Plot to 
Screen.

STAR

D
PR O STA R  3.10

1 9 - O c t - O G

G RA PH  PLO T 
FRA M E 1

Рис. 10.24. Значение безразмерного комплекса f

Для завершения работы с модулем PROSTAR 
• File>Quit>Quit, Nosave.
Все результаты обработки численного решения, которые 

перенаправлялись во внешний файл, сохранены в нейтральном 
графическом файле -  star.plot.

B o u n d a ry  R eg ion  E n g in ee rin g  D a ta

ITERA TIO N  NUM BER
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10.8. Применение утилиты PLOT 
для оформления результатов расчета

Закройте или минимизируйте все запущенные приложения, 
чтобы на поверхности экрана было открыто только окно "Star- 
CD Launcher’.

• Выберите в окне "Star-CD Launcher” пункт меню: Neutral 
Plot Utilities>Plot-GIF, в результате появится терминальное ок­
но утилиты для конвертации графических данных в GIF-формат.

Измените размеры окна, свернув так, как показано на рис. 
10.25, и переместите его в левую верхнюю часть экрана, чтобы 
середина экрана монитора была освобождена для вывода преоб­
разуемых кадров.

OUTPUT FILENAME FOR FIRST FRAME IS starlD O O O i.g if 
BLACK OR WHITE BACKGROUND (DEFAULT=BLACK) ? 

white

ENTER NAME OF NEUTRAL FILE < D E F = s ta r.p lo t)  ?

ALL FILE NAMES WILL CONTAIN A BASE NAME FOLLOWED BV A FRAME INDEX AND 
THE . g i f  EXTENSION.
ENTER THE BASE NAME FOR FILE OUTPUT (DEFAULT IS s t a r ) :

ENTER THE DESIRED WIDTH OF THE PLOT (DEFAULT IS 7 5 7 ):

C:\PROGRA~1\CD-ADA-1\STAR-C~1\bin\plot-gif.

Рис. 10.25. Терминальное окно утилиты конвертации графических данных

Последовательно ответьте на следующие вопросы:
-  ENTER NAME OF NEUTRAL FILE
• Нажмите клавишу Enter для оставления имени по умол­

чанию.
-  ENTER THE BASE NAME FOR FILE OUTPUT
• Нажмите клавишу Enter для оставления имени по умол­

чанию.
-  BLACK OR WHITE BACKGROUND
• Наберите white (предпочтительней).
• Нажмите клавишу Enter.
-  ENTER THE DESIRED WIDTH OF THE PLOT
• Нажмите клавишу Enter для оставления имени по умол­

чанию.
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На экран монитора будут последовательно выводиться кад­
ры, которые затем будут сохраняться в GIF-формате в рабочей 
папке Lab2 с названиями StarXXXXX.GIF.

10.9. Приложение

Представим результаты расчетов в случае, если бы рабочая 
жидкостью была вода, при числах Рейнольдса, равных 400, 2500. 
Для проведения расчетов необходимо определить скорость дви­
жения верхней стенки, исходя из определения числа Re. 

р UI
Re =-

о
где р = 999,9кг/ м -  плотность воды;

р = 0,001006кг/ м -с  -  динамический коэффициент вязко­

сти при температуре Т = 293 К;
I = 1 м -  длина стенки.
Выразим U через Re, подставим значение числа Re:

Re • рU =
р I

400 -0,001006
^  Re =400 “  д д д  д  | ~ 0,0004024 М  / С \

2500-0,001006 ,
Grp-ocaa = ------------------------= 0,002515 м/ с .К е  - Z 3 U U  д д д  д  ^

Проведя численный эксперимент в программе Star-CD, бы­
ли получены следующие результаты (рис. 10.26 и 10.27).

Анализируя данные результаты можно сказать, что увели­
чение числа Re приводит к развитию центрального вихря, что 
согласуется с результатами, приведенными в [2]. В работе [2] 
приводится более подробный анализ течения в зависимости от 
числа Re, соотношения размеров поперечной и продольных сто­
рон квадратной полости.
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STAR

D
PR O ST A R  3,10

2 5 - O c t - 0 6  
STR E A M  FU N CTIO N

ITER = 500
LO CA L MX= 0 .3 B 0 0 E -0 1  
LO CA L MN= 0 ,1 9 4 8 E -0 3

A 0.3472E-Q1
0.3217E-01 

С 0.2961 E-01
0.2705E-01 

E 0.2449E-01
F 0.2193E-01

0.1938E-01 
0.16S2E-01 
0.1426E-01 
0.1170E-01 
0.9146E-02 
0.6589E-02 

M 0.4031 E-02
N 0.1474E-02

V

Рис. 10.26. Поле линий тока для Re = 400

STAR

D
PR O ST A R  3,10

2 5 - O c t - 0 6  
STR E A M  FU N CTIO N

ITER = 49
LO CA L MX= 0 ,1 5 4 7  
LO CA L MN= 0 ,2 3 1 5 E -0 3

A 0.1492 
0.1382 

С 0.1271 
0.1161 

E 0.1051 
F 0.9402E-01 

0.8298E-01 
0.7195E-01 
0.6092E-01 
0.4988E-01 
0.3885E-01 
0.2782E-01 

M 0.1678E-01 
IM 0.5748E-02

V

Рис. 10.27. Поле линий тока тока для Re = 2500
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